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Basic Safety Instructions

Always read through and comply with the following safety instructions!

All plants and locations of the Rohde & Schwarz group of companies make every
effort to keep the safety standards of our products up to date and to offer our
customers the highest possible degree of safety. Our products and the auxiliary
equipment they require are designed, built and tested in accordance with the
safety standards that apply in each case. Compliance with these standards is
continuously monitored by our quality assurance system. The product described
here has been designed, built and tested in accordance with the EC Certificate of
Conformity and has left the manufacturer’s plant in a condition fully complying
with safety standards. To maintain this condition and to ensure safe operation,
you must observe all instructions and warnings provided in this manual. If you
have any questions regarding these safety instructions, the Rohde & Schwarz
group of companies will be happy to answer them.

Furthermore, it is your responsibility to use the product in an appropriate manner.
This product is designed for use solely in industrial and laboratory environments
or, if expressly permitted, also in the field and must not be used in any way that
may cause personal injury or property damage. You are responsible if the product
Is used for any purpose other than its designated purpose or in disregard of the
manufacturer's instructions. The manufacturer shall assume no responsibility for
such use of the product.

The product is used for its designated purpose if it is used in accordance with its
product documentation and within its performance limits (see data sheet,
documentation, the following safety instructions). Using the product requires
technical skills and, in some cases, a basic knowledge of English. It is therefore
essential that only skilled and specialized staff or thoroughly trained personnel
with the required skills be allowed to use the product. If personal safety gear is
required for using Rohde & Schwarz products, this will be indicated at the
appropriate place in the product documentation. Keep the basic safety
instructions and the product documentation in a safe place and pass them on to
the subsequent users.
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Basic Safety Instructions

Observing the safety instructions will help prevent personal injury or damage of
any kind caused by dangerous situations. Therefore, carefully read through and
adhere to the following safety instructions before and when using the product. It is
also absolutely essential to observe the additional safety instructions on personal
safety, for example, that appear in relevant parts of the product documentation. In
these safety instructions, the word "product” refers to all merchandise sold and
distributed by the Rohde & Schwarz group of companies, including instruments,
systems and all accessories. For product-specific information, see the data sheet
and the product documentation.

Safety labels on products

The following safety labels are used on products to warn against risks and
dangers.

Symbol | Meaning Symbol | Meaning

_ Notice, general danger location | O | ON/OFF Power

/ & \ | Observe product documentation

Caution when handling heavy d) Standby indication

A equipment
| 18 kg |

c Danger of electric shock ppp Direct current (DC)

c Caution ! Hot surface ~_ Alternating current (AC)

Protective conductor terminal = Direct/alternating current (DC/AC)

To identify any terminal which is

intended for connection to an

external conductor for protection

against electric shock in case of a

fault, or the terminal of a

protective earth

| Earth (Ground) ] Class Il Equipment
- to identify equipment meeting the
= safety requirements specified for
Class Il equipment
(device protected by double or
reinforced insulation)

Frame or chassis Ground terminal EU labeling for batteries and
accumulators. For additional
information, see section "Waste
disposal/Environmental
protection", item 1.
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Basic Safety Instructions

Symbol | Meaning Symbol | Meaning

Be careful when handling
electrostatic sensitive devices

EU labeling for separate collection
of electrical and electronic devices

For additional information, see
section "Waste
disposal/Environmental
protection", item 2.

Warning! Laser radiation

For additional information, see
section "Operation”, item 7.

Signal words and their meaning

The following signal words are used in the product documentation in order to
warn the reader about risks and dangers.

A DANGER Indicates a hazardous situation which, if not avoided, will
result in death or serious injury.

Indicates a hazardous situation which, if not avoided, could
result in death or serious injury.

A WARNING

Indicates a hazardous situation which, if not avoided, could

A CAUTION T .
result in minor or moderate injury.

m Indicates information considered important, but not hazard-
related, e.g. messages relating to property damage.
In the product documentation, the word ATTENTION is
used synonymously.

These signal words are in accordance with the standard definition for civil
applications in the European Economic Area. Definitions that deviate from the
standard definition may also exist in other economic areas or military applications.
It is therefore essential to make sure that the signal words described here are
always used only in connection with the related product documentation and the
related product. The use of signal words in connection with unrelated products or
documentation can result in misinterpretation and in personal injury or material
damage.
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Basic Safety Instructions

Operating states and operating positions

The product may be operated only under the operating conditions and in the
positions specified by the manufacturer, without the product's ventilation being
obstructed. If the manufacturer's specifications are not observed, this can result in
electric shock, fire and/or serious personal injury or death. Applicable local or
national safety regulations and rules for the prevention of accidents must be
observed in all work performed.

1.

Unless otherwise specified, the following requirements apply to Rohde &
Schwarz products:

predefined operating position is always with the housing floor facing down, IP
protection 2X, use only indoors, max. operating altitude 2000 m above sea
level, max. transport altitude 4500 m above sea level. A tolerance of +10 %
shall apply to the nominal voltage and £5 % to the nominal frequency,
overvoltage category 2, pollution degree 2.

. Do not place the product on surfaces, vehicles, cabinets or tables that for

reasons of weight or stability are unsuitable for this purpose. Always follow the
manufacturer's installation instructions when installing the product and
fastening it to objects or structures (e.g. walls and shelves). An installation that
Is not carried out as described in the product documentation could result in
personal injury or even death.

Do not place the product on heat-generating devices such as radiators or fan
heaters. The ambient temperature must not exceed the maximum temperature
specified in the product documentation or in the data sheet. Product
overheating can cause electric shock, fire and/or serious personal injury or
even death.

Electrical safety

If the information on electrical safety is not observed either at all or to the extent
necessary, electric shock, fire and/or serious personal injury or death may occur.

1.

Prior to switching on the product, always ensure that the nominal voltage
setting on the product matches the nominal voltage of the mains-supply
network. If a different voltage is to be set, the power fuse of the product may
have to be changed accordingly.

. In the case of products of safety class | with movable power cord and

connector, operation is permitted only on sockets with a protective conductor
contact and protective conductor.
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Basic Safety Instructions

. Intentionally breaking the protective conductor either in the feed line or in the
product itself is not permitted. Doing so can result in the danger of an electric
shock from the product. If extension cords or connector strips are
implemented, they must be checked on a regular basis to ensure that they are
safe to use.

. If there is no power switch for disconnecting the product from the mains, or if
the power switch is not suitable for this purpose, use the plug of the
connecting cable to disconnect the product from the mains. In such cases,
always ensure that the power plug is easily reachable and accessible at all
times. For example, if the power plug is the disconnecting device, the length of
the connecting cable must not exceed 3 m. Functional or electronic switches
are not suitable for providing disconnection from the AC supply network. If
products without power switches are integrated into racks or systems, the
disconnecting device must be provided at the system level.

. Never use the product if the power cable is damaged. Check the power cables
on a regular basis to ensure that they are in proper operating condition. By
taking appropriate safety measures and carefully laying the power cable,
ensure that the cable cannot be damaged and that no one can be hurt by, for
example, tripping over the cable or suffering an electric shock.

. The product may be operated only from TN/TT supply networks fuse-protected
with max. 16 A (higher fuse only after consulting with the Rohde & Schwarz
group of companies).

. Do not insert the plug into sockets that are dusty or dirty. Insert the plug firmly
and all the way into the socket provided for this purpose. Otherwise, sparks
that result in fire and/or injuries may occur.

. Do not overload any sockets, extension cords or connector strips; doing so
can cause fire or electric shocks.

. For measurements in circuits with voltages Vrms > 30 V, suitable measures
(e.g. appropriate measuring equipment, fuse protection, current limiting,
electrical separation, insulation) should be taken to avoid any hazards.

10.Ensure that the connections with information technology equipment, e.g. PCs

or other industrial computers, comply with the IEC 60950-1 / EN 60950-1 or
IEC 61010-1/ EN 61010-1 standards that apply in each case.

11.Unless expressly permitted, never remove the cover or any part of the housing

while the product is in operation. Doing so will expose circuits and
components and can lead to injuries, fire or damage to the product.
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Basic Safety Instructions

12.1f a product is to be permanently installed, the connection between the
protective conductor terminal on site and the product's protective conductor
must be made first before any other connection is made. The product may be
installed and connected only by a licensed electrician.

13.For permanently installed equipment without built-in fuses, circuit breakers or
similar protective devices, the supply circuit must be fuse-protected in such a
way that anyone who has access to the product, as well as the product itself,
is adequately protected from injury or damage.

14.Use suitable overvoltage protection to ensure that no overvoltage (such as
that caused by a bolt of lightning) can reach the product. Otherwise, the
person operating the product will be exposed to the danger of an electric
shock.

15.Any object that is not designed to be placed in the openings of the housing
must not be used for this purpose. Doing so can cause short circuits inside the
product and/or electric shocks, fire or injuries.

16.Unless specified otherwise, products are not liquid-proof (see also section
"Operating states and operating positions", item 1). Therefore, the equipment
must be protected against penetration by liquids. If the necessary precautions
are not taken, the user may suffer electric shock or the product itself may be
damaged, which can also lead to personal injury.

17.Never use the product under conditions in which condensation has formed or
can form in or on the product, e.qg. if the product has been moved from a cold
to a warm environment. Penetration by water increases the risk of electric
shock.

18.Prior to cleaning the product, disconnect it completely from the power supply
(e.g. AC supply network or battery). Use a soft, non-linting cloth to clean the
product. Never use chemical cleaning agents such as alcohol, acetone or
diluents for cellulose lacquers.

Operation

1. Operating the products requires special training and intense concentration.
Make sure that persons who use the products are physically, mentally and
emotionally fit enough to do so; otherwise, injuries or material damage may
occur. It is the responsibility of the employer/operator to select suitable
personnel for operating the products.

2. Before you move or transport the product, read and observe the section titled
"Transport".
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As with all industrially manufactured goods, the use of substances that induce
an allergic reaction (allergens) such as nickel cannot be generally excluded. If
you develop an allergic reaction (such as a skin rash, frequent sneezing, red
eyes or respiratory difficulties) when using a Rohde & Schwarz product,
consult a physician immediately to determine the cause and to prevent health
problems or stress.

Before you start processing the product mechanically and/or thermally, or
before you take it apart, be sure to read and pay special attention to the
section titled "Waste disposal/Environmental protection”, item 1.

Depending on the function, certain products such as RF radio equipment can
produce an elevated level of electromagnetic radiation. Considering that
unborn babies require increased protection, pregnant women must be
protected by appropriate measures. Persons with pacemakers may also be
exposed to risks from electromagnetic radiation. The employer/operator must
evaluate workplaces where there is a special risk of exposure to radiation and,
If necessary, take measures to avert the potential danger.

6. Should a fire occur, the product may release hazardous substances (gases,
fluids, etc.) that can cause health problems. Therefore, suitable measures
must be taken, e.g. protective masks and protective clothing must be worn.

. Laser products are given warning labels that are standardized according to
their laser class. Lasers can cause biological harm due to the properties of
their radiation and due to their extremely concentrated electromagnetic power.
If a laser product (e.g. a CD/DVD drive) is integrated into a Rohde & Schwarz
product, absolutely no other settings or functions may be used as described in
the product documentation. The objective is to prevent personal injury (e.g.
due to laser beams).

8. EMC classes (in line with EN 55011/CISPR 11, and analogously with EN
55022/CISPR 22, EN 55032/CISPR 32)

— Class A equipment:
Equipment suitable for use in all environments except residential
environments and environments that are directly connected to a low-
voltage supply network that supplies residential buildings
Note: Class A equipment is intended for use in an industrial environment.
This equipment may cause radio disturbances in residential environments,
due to possible conducted as well as radiated disturbances. In this case,
the operator may be required to take appropriate measures to eliminate
these disturbances.
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— Class B equipment:
Equipment suitable for use in residential environments and environments
that are directly connected to a low-voltage supply network that supplies
residential buildings

Repair and service

1.

The product may be opened only by authorized, specially trained personnel.
Before any work is performed on the product or before the product is opened,
it must be disconnected from the AC supply network. Otherwise, personnel will
be exposed to the risk of an electric shock.

Adjustments, replacement of parts, maintenance and repair may be performed
only by electrical experts authorized by Rohde & Schwarz. Only original parts
may be used for replacing parts relevant to safety (e.g. power switches, power
transformers, fuses). A safety test must always be performed after parts
relevant to safety have been replaced (visual inspection, protective conductor
test, insulation resistance measurement, leakage current measurement,
functional test). This helps ensure the continued safety of the product.

Batteries and rechargeable batteries/cells

If the information regarding batteries and rechargeable batteries/cells is not
observed either at all or to the extent necessary, product users may be exposed
to the risk of explosions, fire and/or serious personal injury, and, in some cases,
death. Batteries and rechargeable batteries with alkaline electrolytes (e.g. lithium
cells) must be handled in accordance with the EN 62133 standard.

1.
2.

Cells must not be taken apart or crushed.

Cells or batteries must not be exposed to heat or fire. Storage in direct sunlight
must be avoided. Keep cells and batteries clean and dry. Clean soiled
connectors using a dry, clean cloth.

Cells or batteries must not be short-circuited. Cells or batteries must not be
stored in a box or in a drawer where they can short-circuit each other, or
where they can be short-circuited by other conductive materials. Cells and
batteries must not be removed from their original packaging until they are
ready to be used.

Cells and batteries must not be exposed to any mechanical shocks that are
stronger than permitted.

If a cell develops a leak, the fluid must not be allowed to come into contact
with the skin or eyes. If contact occurs, wash the affected area with plenty of
water and seek medical aid.
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6. Improperly replacing or charging cells or batteries that contain alkaline
electrolytes (e.g. lithium cells) can cause explosions. Replace cells or batteries
only with the matching Rohde & Schwarz type (see parts list) in order to
ensure the safety of the product.

7. Cells and batteries must be recycled and kept separate from residual waste.
Rechargeable batteries and normal batteries that contain lead, mercury or
cadmium are hazardous waste. Observe the national regulations regarding
waste disposal and recycling.

Transport

1. The product may be very heavy. Therefore, the product must be handled with
care. In some cases, the user may require a suitable means of lifting or
moving the product (e.g. with a lift-truck) to avoid back or other physical
injuries.

2. Handles on the products are designed exclusively to enable personnel to
transport the product. It is therefore not permissible to use handles to fasten
the product to or on transport equipment such as cranes, fork lifts, wagons,
etc. The user is responsible for securely fastening the products to or on the
means of transport or lifting. Observe the safety regulations of the
manufacturer of the means of transport or lifting. Noncompliance can result in
personal injury or material damage.

3. If you use the product in a vehicle, it is the sole responsibility of the driver to
drive the vehicle safely and properly. The manufacturer assumes no
responsibility for accidents or collisions. Never use the product in a moving
vehicle if doing so could distract the driver of the vehicle. Adequately secure
the product in the vehicle to prevent injuries or other damage in the event of
an accident.

Waste disposal/Environmental protection

1. Specially marked equipment has a battery or accumulator that must not be
disposed of with unsorted municipal waste, but must be collected separately. It
may only be disposed of at a suitable collection point or via a
Rohde & Schwarz customer service center.

2. Waste electrical and electronic equipment must not be disposed of with
unsorted municipal waste, but must be collected separately.
Rohde & Schwarz GmbH & Co. KG has developed a disposal concept and
takes full responsibility for take-back obligations and disposal obligations for
manufacturers within the EU. Contact your Rohde & Schwarz customer
service center for environmentally responsible disposal of the product.
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Instrucciones de seguridad elementales

3. If products or their components are mechanically and/or thermally processed
in a manner that goes beyond their intended use, hazardous substances
(heavy-metal dust such as lead, beryllium, nickel) may be released. For this
reason, the product may only be disassembled by specially trained personnel.
Improper disassembly may be hazardous to your health. National waste
disposal regulations must be observed.

4. If handling the product releases hazardous substances or fuels that must be
disposed of in a special way, e.g. coolants or engine oils that must be
replenished regularly, the safety instructions of the manufacturer of the
hazardous substances or fuels and the applicable regional waste disposal
regulations must be observed. Also observe the relevant safety instructions in
the product documentation. The improper disposal of hazardous substances
or fuels can cause health problems and lead to environmental damage.

For additional information about environmental protection, visit the
Rohde & Schwarz website.

Instrucciones de seguridad elementales

iEs imprescindible leer y cumplir las siguientes instrucciones e
informaciones de seguridad!

El principio del grupo de empresas Rohde & Schwarz consiste en tener nuestros
productos siempre al dia con los estandares de seguridad y de ofrecer a nuestros
clientes el maximo grado de seguridad. Nuestros productos y todos los equipos
adicionales son siempre fabricados y examinados segun las normas de
seguridad vigentes. Nuestro sistema de garantia de calidad controla
constantemente que sean cumplidas estas normas. El presente producto ha sido
fabricado y examinado segun el certificado de conformidad de la UE y ha salido
de nuestra planta en estado impecable segun los estandares técnicos de
seguridad. Para poder preservar este estado y garantizar un funcionamiento libre
de peligros, el usuario debera atenerse a todas las indicaciones, informaciones
de seguridad y notas de alerta. El grupo de empresas Rohde & Schwarz esta
siempre a su disposicion en caso de que tengan preguntas referentes a estas
informaciones de seguridad.
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Instrucciones de seguridad elementales

Ademas queda en la responsabilidad del usuario utilizar el producto en la forma
debida. Este producto esta destinado exclusivamente al uso en la industria y el
laboratorio o, si ha sido expresamente autorizado, para aplicaciones de campo y
de ninguna manera debera ser utilizado de modo que alguna persona/cosa
pueda sufrir dafio. El uso del producto fuera de sus fines definidos o sin tener en
cuenta las instrucciones del fabricante queda en la responsabilidad del usuario.
El fabricante no se hace en ninguna forma responsable de consecuencias a
causa del mal uso del producto.

Se parte del uso correcto del producto para los fines definidos si el producto es
utilizado conforme a las indicaciones de la correspondiente documentacion del
producto y dentro del margen de rendimiento definido (ver hoja de datos,
documentacién, informaciones de seguridad que siguen). El uso del producto
hace necesarios conocimientos técnicos y ciertos conocimientos del idioma
inglés. Por eso se debe tener en cuenta que el producto solo pueda ser operado
por personal especializado o personas instruidas en profundidad con las
capacidades correspondientes. Si fuera necesaria indumentaria de seguridad
para el uso de productos de Rohde & Schwarz, encontraria la informacién debida
en la documentacion del producto en el capitulo correspondiente. Guarde bien
las informaciones de seguridad elementales, asi como la documentacioén del
producto, y entréguelas a usuarios posteriores.

Tener en cuenta las informaciones de seguridad sirve para evitar en lo posible
lesiones o dafos por peligros de toda clase. Por eso es imprescindible leer
detalladamente y comprender por completo las siguientes informaciones de
seguridad antes de usar el producto, y respetarlas durante el uso del producto.
Deberan tenerse en cuenta todas las demas informaciones de seguridad, como
p. €]. las referentes a la proteccion de personas, que encontraran en el capitulo
correspondiente de la documentacion del producto y que también son de
obligado cumplimiento. En las presentes informaciones de seguridad se recogen
todos los objetos que distribuye el grupo de empresas Rohde & Schwarz bajo la
denominacion de "producto”, entre ellos también aparatos, instalaciones asi
como toda clase de accesorios. Los datos especificos del producto figuran en la
hoja de datos y en la documentacion del producto.
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Instrucciones de seguridad elementales

Sefalizacion de seguridad de los productos

Las siguientes sefales de seguridad se utilizan en los productos para advertir
sobre riesgos y peligros.

\
3
o
=]
S)

Significado

Simbolo

Significado

Aviso: punto de peligro general

Observar la documentacion del
producto

| O

Tension de alimentacion de
PUESTA EN MARCHA / PARADA

Atencion en el manejo de
dispositivos de peso elevado

O

Indicacion de estado de espera
(standby)

Peligro de choque eléctrico

Corriente continua (DC)

Advertencia: superficie caliente ~ Corriente alterna (AC)
Conexion a conductor de == Corriente continua / Corriente
proteccion alterna (DC/AC)

Conexion a tierra O El aparato esta protegido en su

totalidad por un aislamiento doble
(reforzado)

EEERP>D B>

Conexién a masa

Distintivo de la UE para baterias y
acumuladores

Mas informacién en la seccién
"Eliminacion/proteccion del medio
ambiente", punto 1.

>

Aviso: Cuidado en el manejo de
dispositivos sensibles a la
electrostatica (ESD)

Distintivo de la UE para la
eliminacion por separado de
dispositivos eléctricos y
electronicos

Mas informacién en la seccién
"Eliminacion/proteccion del medio
ambiente”, punto 2.

7~

Advertencia: rayo laser

Mas informacién en la seccién
"Funcionamiento”, punto 7.
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Instrucciones de seguridad elementales

Palabras de sefial y su significado

En la documentacion del producto se utilizan las siguientes palabras de sefal
con el fin de advertir contra riesgos y peligros.

A PELIGRO Indica una situacién de peligro que, si no se evita,

causa lesiones graves o incluso la muerte.

Indica una situacién de peligro que, si no se evita,

A ADVERTENCIA : )
puede causar lesiones graves o incluso la muerte.

Indica una situacion de peligro que, si no se evita,

A ATENCION :
puede causar lesiones leves o moderadas.

m Indica informacién que se considera importante, pero
no en relacién con situaciones de peligro; p. €j., avisos
sobre posibles dafios materiales.
En la documentacion del producto se emplea de forma
sinénima el término CUIDADO.

Las palabras de sefial corresponden a la definicion habitual para aplicaciones
civiles en el area econdmica europea. Pueden existir definiciones diferentes a
esta definicion en otras areas economicas o en aplicaciones militares. Por eso se
debera tener en cuenta que las palabras de sefal aqui descritas sean utilizadas
siempre solamente en combinacion con la correspondiente documentacion del
producto y solamente en combinacion con el producto correspondiente. La
utilizacion de las palabras de sefial en combinacién con productos o
documentaciones que no les correspondan puede llevar a interpretaciones
equivocadas y tener por consecuencia dafos en personas u objetos.
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Instrucciones de seguridad elementales

Estados operativos y posiciones de funcionamiento

El producto solamente debe ser utilizado segun lo indicado por el fabricante
respecto a los estados operativos y posiciones de funcionamiento sin que se
obstruya la ventilacion. Si no se siguen las indicaciones del fabricante, pueden
producirse choques eléctricos, incendios y/o lesiones graves con posible
consecuencia de muerte. En todos los trabajos deberan ser tenidas en cuenta las
normas nacionales y locales de seguridad del trabajo y de prevencion de
accidentes.

1. Sino se convino de otra manera, es para los productos Rohde & Schwarz
valido lo que sigue:
como posicion de funcionamiento se define por principio la posicion con el
suelo de la caja para abajo, modo de proteccién IP 2X, uso solamente en
estancias interiores, utilizaciéon hasta 2000 m sobre el nivel del mar, transporte
hasta 4500 m sobre el nivel del mar. Se aplicara una tolerancia de £10 %
sobre el voltaje nominal y de +5 % sobre la frecuencia nominal. Categoria de
sobrecarga eléctrica 2, indice de suciedad 2.

2. No situe el producto encima de superficies, vehiculos, estantes o mesas, que
por sus caracteristicas de peso o de estabilidad no sean aptos para él. Siga
siempre las instrucciones de instalacion del fabricante cuando instale y
asegure el producto en objetos o estructuras (p. ej. paredes y estantes). Si se
realiza la instalacién de modo distinto al indicado en la documentacién del
producto, se pueden causar lesiones o, en determinadas circunstancias,
incluso la muerte.

3. No ponga el producto sobre aparatos que generen calor (p. ej. radiadores o
calefactores). La temperatura ambiente no debe superar la temperatura
maxima especificada en la documentacion del producto o en la hoja de datos.
En caso de sobrecalentamiento del producto, pueden producirse choques
eléctricos, incendios y/o lesiones graves con posible consecuencia de muerte.

Seguridad eléctrica

Si no se siguen (o se siguen de modo insuficiente) las indicaciones del fabricante
en cuanto a seguridad eléctrica, pueden producirse choques eléctricos, incendios
y/o lesiones graves con posible consecuencia de muerte.

1. Antes de la puesta en marcha del producto se deberd comprobar siempre que
la tension preseleccionada en el producto coincida con la de la red de
alimentacion eléctrica. Si es necesario modificar el ajuste de tension, también
se deberan cambiar en caso dado los fusibles correspondientes del producto.

1171.0000.52 - 08 Page 14



Instrucciones de seguridad elementales

2. Los productos de la clase de proteccion | con alimentacién movil y enchufe
individual solamente podran enchufarse a tomas de corriente con contacto de
seguridad y con conductor de proteccion conectado.

3. Queda prohibida la interrupcion intencionada del conductor de proteccion,
tanto en la toma de corriente como en el mismo producto. La interrupcion
puede tener como consecuencia el riesgo de que el producto sea fuente de
choques eléctricos. Si se utilizan cables alargadores o regletas de enchufe,
debera garantizarse la realizacion de un examen regular de los mismos en
cuanto a su estado técnico de seguridad.

4. Si el producto no esta equipado con un interruptor para desconectarlo de la
red, o bien si el interruptor existente no resulta apropiado para la desconexiéon
de la red, el enchufe del cable de conexion se debera considerar como un
dispositivo de desconexion.

El dispositivo de desconexidon se debe poder alcanzar facilmente y debe estar
siempre bien accesible. Si, p. €j., el enchufe de conexion a la red es el
dispositivo de desconexion, la longitud del cable de conexion no debe superar
3 m).

Los interruptores selectores o electrénicos no son aptos para el corte de la red
eléctrica. Si se integran productos sin interruptor en bastidores o
instalaciones, se debera colocar el interruptor en el nivel de la instalacion.

5. No utilice nunca el producto si esta dafiado el cable de conexion a red.
Compruebe regularmente el correcto estado de los cables de conexién a red.
Asegurese, mediante las medidas de proteccién y de instalacion adecuadas,
de que el cable de conexion a red no pueda ser dafiado o de que nadie pueda
ser dafiado por él, p. ej. al tropezar o por un choque eléctrico.

6. Solamente esta permitido el funcionamiento en redes de alimentacion TN/TT
aseguradas con fusibles de 16 A como maximo (utilizacion de fusibles de
mayor amperaje solo previa consulta con el grupo de empresas Rohde &
Schwarz).

7. Nunca conecte el enchufe en tomas de corriente sucias o llenas de polvo.
Introduzca el enchufe por completo y fuertemente en la toma de corriente. La
no observacion de estas medidas puede provocar chispas, fuego y/o lesiones.

8. No sobrecargue las tomas de corriente, los cables alargadores o las regletas
de enchufe ya que esto podria causar fuego o choques eléctricos.

9. En las mediciones en circuitos de corriente con una tension Ueff > 30 V se
deberan tomar las medidas apropiadas para impedir cualquier peligro (p. €j.
medios de medicion adecuados, seguros, limitacién de tensién, corte
protector, aislamiento etc.).
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10.Para la conexion con dispositivos informéaticos como un PC o un ordenador
industrial, debe comprobarse que éstos cumplan los estandares IEC60950-
1/EN60950-1 o IEC61010-1/EN 61010-1 validos en cada caso.

11.A menos que esté permitido expresamente, no retire nunca la tapa ni
componentes de la carcasa mientras el producto esté en servicio. Esto pone a
descubierto los cables y componentes eléctricos y puede causar lesiones,
fuego o dafios en el producto.

12.Si un producto se instala en un lugar fijo, se debera primero conectar el
conductor de proteccion fijo con el conductor de proteccion del producto antes
de hacer cualquier otra conexion. La instalacion y la conexion deberan ser
efectuadas por un electricista especializado.

13.En el caso de dispositivos fijos que no estén provistos de fusibles, interruptor
automatico ni otros mecanismos de seguridad similares, el circuito de
alimentaciéon debe estar protegido de modo que todas las personas que
puedan acceder al producto, asi como el producto mismo, estén a salvo de
posibles dafos.

14.Todo producto debe estar protegido contra sobretension (debida p. €j. a una
caida del rayo) mediante los correspondientes sistemas de proteccion. Si no,
el personal que lo utilice quedara expuesto al peligro de choque eléctrico.

15.No debe introducirse en los orificios de la caja del aparato ningun objeto que
no esté destinado a ello. Esto puede producir cortocircuitos en el producto y/o
puede causar choques eléctricos, fuego o lesiones.

16.Salvo indicacion contraria, los productos no estan impermeabilizados (ver
también el capitulo "Estados operativos y posiciones de funcionamiento”,
punto 1). Por eso es necesario tomar las medidas necesarias para evitar la
entrada de liquidos. En caso contrario, existe peligro de choque eléctrico para
el usuario o de dafios en el producto, que también pueden redundar en
peligro para las personas.

17.No utilice el producto en condiciones en las que pueda producirse o ya se
hayan producido condensaciones sobre el producto o en el interior de éste,
como p. €j. al desplazarlo de un lugar frio a otro caliente. La entrada de agua
aumenta el riesgo de choque eléctrico.

18.Antes de la limpieza, desconecte por completo el producto de la alimentacion
de tension (p. ej. red de alimentacion o bateria). Realice la limpieza de los
aparatos con un pafio suave, que no se deshilache. No utilice bajo ningun
concepto productos de limpieza quimicos como alcohol, acetona o diluyentes
para lacas nitrocelulésicas.
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Funcionamiento

1.

El uso del producto requiere instrucciones especiales y una alta concentracion
durante el manejo. Debe asegurarse que las personas que manejen el
producto estén a la altura de los requerimientos necesarios en cuanto a
aptitudes fisicas, psiquicas y emocionales, ya que de otra manera no se
pueden excluir lesiones o dafios de objetos. El empresario u operador es
responsable de seleccionar el personal usuario apto para el manejo del
producto.

. Antes de desplazar o transportar el producto, lea y tenga en cuenta el capitulo

"Transporte".

Como con todo producto de fabricacion industrial no puede quedar excluida
en general la posibilidad de que se produzcan alergias provocadas por
algunos materiales empleados —los llamados alérgenos (p. €j. el niquel)—. Si
durante el manejo de productos Rohde & Schwarz se producen reacciones
alérgicas, como p. €j. irritaciones cutaneas, estornudos continuos,
enrojecimiento de la conjuntiva o dificultades respiratorias, debe avisarse
inmediatamente a un médico para investigar las causas y evitar cualquier
molestia o dafio a la salud.

Antes de la manipulacién mecanica y/o térmica o el desmontaje del producto,
debe tenerse en cuenta imprescindiblemente el capitulo
"Eliminacion/proteccion del medio ambiente”, punto 1.

Ciertos productos, como p. €j. las instalaciones de radiocomunicacion RF,
pueden a causa de su funcion natural, emitir una radiacion electromagnética
aumentada. Deben tomarse todas las medidas necesarias para la proteccion
de las mujeres embarazadas. También las personas con marcapasos pueden
correr peligro a causa de la radiacion electromagnética. El
empresario/operador tiene la obligacion de evaluar y sefializar las areas de
trabajo en las que exista un riesgo elevado de exposicion a radiaciones.

Tenga en cuenta que en caso de incendio pueden desprenderse del producto
sustancias toxicas (gases, liquidos etc.) que pueden generar dafios a la salud.
Por eso, en caso de incendio deben usarse medidas adecuadas, como p. €j.
mascaras antigas e indumentaria de proteccion.
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Instrucciones de seguridad elementales

7. Los productos con laser estan provistos de indicaciones de advertencia
normalizadas en funcién de la clase de laser del que se trate. Los rayos laser
pueden provocar dafios de tipo biolégico a causa de las propiedades de su
radiacion y debido a su concentracion extrema de potencia electromagnética.
En caso de que un producto Rohde & Schwarz contenga un producto laser (p.
ej. un lector de CD/DVD), no debe usarse ninguna otra configuracién o
funcion aparte de las descritas en la documentacion del producto, a fin de
evitar lesiones (p. €j. debidas a irradiacion laser).

8. Clases de compatibilidad electromagnética (conforme a EN 55011 / CISPR
11; y en analogia con EN 55022 / CISPR 22, EN 55032 / CISPR 32)

— Aparato de clase A:
Aparato adecuado para su uso en todos los entornos excepto en los
residenciales y en aquellos conectados directamente a una red de
distribucidn de baja tension que suministra corriente a edificios
residenciales.
Nota: Los aparatos de clase A estan destinados al uso en entornos
industriales. Estos aparatos pueden causar perturbaciones radioeléctricas
en entornos residenciales debido a posibles perturbaciones guiadas o
radiadas. En este caso, se le podra solicitar al operador que tome las
medidas adecuadas para eliminar estas perturbaciones.

— Aparato de clase B:
Aparato adecuado para su uso en entornos residenciales, asi como en
aguellos conectados directamente a una red de distribucion de baja
tensidn que suministra corriente a edificios residenciales.

Reparacién y mantenimiento

1. El producto solamente debe ser abierto por personal especializado con
autorizacion para ello. Antes de manipular el producto o abrirlo, es obligatorio
desconectarlo de la tension de alimentacion, para evitar toda posibilidad de
choque eléctrico.

2. El ajuste, el cambio de partes, el mantenimiento y la reparacion deberan ser
efectuadas solamente por electricistas autorizados por Rohde & Schwarz. Si
se reponen partes con importancia para los aspectos de seguridad (p. ej. el
enchufe, los transformadores o los fusibles), solamente podran ser sustituidos
por partes originales. Después de cada cambio de partes relevantes para la
seguridad deberé realizarse un control de seguridad (control a primera vista,
control del conductor de proteccion, medicion de resistencia de aislamiento,
medicion de la corriente de fuga, control de funcionamiento). Con esto queda
garantizada la seguridad del producto.
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Baterias y acumuladores o celdas

Si no se siguen (o se siguen de modo insuficiente) las indicaciones en cuanto a
las baterias y acumuladores o celdas, pueden producirse explosiones, incendios
y/o lesiones graves con posible consecuencia de muerte. El manejo de baterias y
acumuladores con electrolitos alcalinos (p. €j. celdas de litio) debe seguir el
estandar EN 62133.

1. No deben desmontarse, abrirse ni triturarse las celdas.

2. Las celdas o baterias no deben someterse a calor ni fuego. Debe evitarse el
almacenamiento a la luz directa del sol. Las celdas y baterias deben
mantenerse limpias y secas. Limpiar las conexiones sucias con un pafio seco
y limpio.

3. Las celdas o baterias no deben cortocircuitarse. Es peligroso almacenar las
celdas o baterias en estuches o cajones en cuyo interior puedan
cortocircuitarse por contacto reciproco o por contacto con otros materiales
conductores. No deben extraerse las celdas o baterias de sus embalajes
originales hasta el momento en que vayan a utilizarse.

4. Las celdas o baterias no deben someterse a impactos mecanicos fuertes
indebidos.

5. En caso de falta de estanqueidad de una celda, el liquido vertido no debe
entrar en contacto con la piel ni los ojos. Si se produce contacto, lavar con
agua abundante la zona afectada y avisar a un médico.

6. En caso de cambio o recarga inadecuados, las celdas o baterias que
contienen electrolitos alcalinos (p. ej. las celdas de litio) pueden explotar. Para
garantizar la seguridad del producto, las celdas o baterias solo deben ser
sustituidas por el tipo Rohde & Schwarz correspondiente (ver lista de
recambios).

7. Las baterias y celdas deben reciclarse y no deben tirarse a la basura
domeéstica. Las baterias o acumuladores que contienen plomo, mercurio o
cadmio deben tratarse como residuos especiales. Respete en esta relacion
las normas nacionales de eliminacion y reciclaje.

Transporte

1. El producto puede tener un peso elevado. Por eso es necesario desplazarlo o
transportarlo con precaucion y, si es necesario, usando un sistema de
elevacion adecuado (p. ej. una carretilla elevadora), a fin de evitar lesiones en
la espalda u otros dafos personales.
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2. Las asas instaladas en los productos sirven solamente de ayuda para el
transporte del producto por personas. Por eso no esta permitido utilizar las
asas para la sujecion en o sobre medios de transporte como p. €j. gruas,
carretillas elevadoras de horquilla, carros etc. Es responsabilidad suya fijar los
productos de manera segura a los medios de transporte o elevacion. Para
evitar dafos personales o dafos en el producto, siga las instrucciones de
seguridad del fabricante del medio de transporte o elevacion utilizado.

3. Si se utiliza el producto dentro de un vehiculo, recae de manera exclusiva en
el conductor la responsabilidad de conducir el vehiculo de manera segura y
adecuada. El fabricante no asumira ninguna responsabilidad por accidentes o
colisiones. No utilice nunca el producto dentro de un vehiculo en movimiento
si esto pudiera distraer al conductor. Asegure el producto dentro del vehiculo
debidamente para evitar, en caso de un accidente, lesiones u otra clase de
dafos.

Eliminacion/proteccién del medio ambiente

1. Los dispositivos marcados contienen una bateria o un acumulador que no se
debe desechar con los residuos domésticos sin clasificar, sino que debe ser
recogido por separado. La eliminacion se debe efectuar exclusivamente a
través de un punto de recogida apropiado o del servicio de atencion al cliente
de Rohde & Schwarz.

2. Los dispositivos eléctricos usados no se deben desechar con los residuos
domésticos sin clasificar, sino que deben ser recogidos por separado.
Rohde & Schwarz GmbH & Co.KG ha elaborado un concepto de eliminacion
de residuos y asume plenamente los deberes de recogida y eliminacién para
los fabricantes dentro de la UE. Para desechar el producto de manera
respetuosa con el medio ambiente, dirijase a su servicio de atencién al cliente
de Rohde & Schwarz.

3. Sise trabaja de manera mecénica y/o térmica cualquier producto o
componente mas alla del funcionamiento previsto, pueden liberarse
sustancias peligrosas (polvos con contenido de metales pesados como p. €].
plomo, berilio o niquel). Por eso el producto solo debe ser desmontado por
personal especializado con formacién adecuada. Un desmontaje inadecuado
puede ocasionar dafios para la salud. Se deben tener en cuenta las directivas
nacionales referentes a la eliminacion de residuos.
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4. En caso de que durante el trato del producto se formen sustancias peligrosas
0 combustibles que deban tratarse como residuos especiales (p. €j.
refrigerantes o aceites de motor con intervalos de cambio definidos), deben
tenerse en cuenta las indicaciones de seguridad del fabricante de dichas
sustancias y las normas regionales de eliminacion de residuos. Tenga en
cuenta también en caso necesario las indicaciones de seguridad especiales
contenidas en la documentaciéon del producto. La eliminacion incorrecta de
sustancias peligrosas o combustibles puede causar dafnos a la salud o dafos
al medio ambiente.

Se puede encontrar mas informacion sobre la proteccion del medio ambiente en
la pagina web de Rohde & Schwarz.
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Grundlegende Sicherheitshinweise

Lesen und beachten Sie unbedingt die nachfolgenden Anweisungen und
Sicherheitshinweise!

Alle Werke und Standorte der Rohde & Schwarz Firmengruppe sind standig
bemiiht, den Sicherheitsstandard unserer Produkte auf dem aktuellsten Stand zu
halten und unseren Kunden ein hdchstmégliches Mal3 an Sicherheit zu bieten.
Unsere Produkte und die dafir erforderlichen Zusatzgerate werden entsprechend
der jeweils gultigen Sicherheitsvorschriften gebaut und gepruft. Die Einhaltung
dieser Bestimmungen wird durch unser Qualitatssicherungssystem laufend
uberwacht. Das vorliegende Produkt ist gemalf beiliegender EU-
Konformitatsbescheinigung gebaut und geprift und hat das Werk in
sicherheitstechnisch einwandfreiem Zustand verlassen. Um diesen Zustand zu
erhalten und einen gefahrlosen Betrieb sicherzustellen, muss der Benutzer alle
Hinweise, Warnhinweise und Warnvermerke beachten. Bei allen Fragen
bezuglich vorliegender Sicherheitshinweise steht Ihnen die Rohde & Schwarz
Firmengruppe jederzeit gerne zur Verfligung.

Dariber hinaus liegt es in der Verantwortung des Benutzers, das Produkt in
geeigneter Weise zu verwenden. Das Produkt ist ausschliel3lich flr den Betrieb in
Industrie und Labor bzw., wenn ausdricklich zugelassen, auch fir den
Feldeinsatz bestimmt und darf in keiner Weise so verwendet werden, dass einer
Person/Sache Schaden zugefligt werden kann. Die Benutzung des Produkts
aul3erhalb des bestimmungsgemalien Gebrauchs oder unter Missachtung der
Anweisungen des Herstellers liegt in der Verantwortung des Benutzers. Der
Hersteller Gbernimmt keine Verantwortung fur die Zweckentfremdung des
Produkts.

Die bestimmungsgemaé&ie Verwendung des Produkts wird angenommen, wenn
das Produkt nach den Vorgaben der zugehorigen Produktdokumentation
innerhalb seiner Leistungsgrenzen verwendet wird (siehe Datenblatt, Doku-
mentation, nachfolgende Sicherheitshinweise). Die Benutzung des Produkts
erfordert Fachkenntnisse und zum Teil englische Sprachkenntnisse. Es ist daher
zu beachten, dass das Produkt ausschlie3lich von Fachkréften oder sorgfaltig
eingewiesenen Personen mit entsprechenden Fahigkeiten bedient werden darf.
Sollte fur die Verwendung von Rohde & Schwarz-Produkten personliche
Schutzausristung erforderlich sein, wird in der Produktdokumentation an
entsprechender Stelle darauf hingewiesen. Bewahren Sie die grundlegenden
Sicherheitshinweise und die Produktdokumentation gut auf und geben Sie diese
an weitere Benutzer des Produkts weiter.
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Die Einhaltung der Sicherheitshinweise dient dazu, Verletzungen oder Schaden
durch Gefahren aller Art auszuschlief3en. Hierzu ist es erforderlich, dass die
nachstehenden Sicherheitshinweise vor der Benutzung des Produkts sorgfaltig
gelesen und verstanden sowie bei der Benutzung des Produkts beachtet werden.
Samtliche weitere Sicherheitshinweise wie z.B. zum Personenschutz, die an
entsprechender Stelle der Produktdokumentation stehen, sind ebenfalls
unbedingt zu beachten. In den vorliegenden Sicherheitshinweisen sind samtliche
von der Rohde & Schwarz Firmengruppe vertriebenen Waren unter dem Begriff
~Produkt zusammengefasst, hierzu zahlen u. a. Geréte, Anlagen sowie
samtliches Zubehor.

Symbole und Sicherheitskennzeichnungen

anforderungen an die
Schutzklasse |l

(Gerét durchgehend durch
doppelte / verstarkte Isolierung
geschutzt.

Symbol | Bedeutung Symbol Bedeutung
\ Achtung, allgemeine | O EIN-/AUS (Versorgung)
/ Gefahrenstelle
" | Produktdokumentation beachten
Vorsicht beim Umgang mit d) Stand-by-Anzeige
A Geraten mit hohem Gewicht
| 18 kg |
c Gefahr vor elektrischem Schlag - Gleichstrom (DC)
c Warnung vor hei3er Oberflache ~ Wechselstrom (AC)
Schutzleiteranschluss == Gleichstrom/Wechselstrom
(DC/AC)
_L Erdungsanschluss 0 Gerét entspricht den Sicherheits-

-

Masseanschluss des Gestells
oder Gehéuses

EU - Kennzeichnung fur Batterien
und Akkumulatoren. Das Gerat
enthalt eine Batterie bzw. einen
Akkumulator. Diese diirfen nicht
Uber unsortierten Siedlungsabfall
entsorgt werden, sondern sollten
getrennt gesammelt werden.

Weitere Informationen siehe
Seite 11.
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Grundlegende Sicherheitshinweise

Symbol | Bedeutung Symbol Bedeutung
Achtung beim Umgang mit 2 EU - Kennzeichnung fur die
elektrostatisch gefahrdeten W getrennte Sammlung von Elektro-
Bauelementen ‘e und Elektronikgeraten.
L Elektroaltgerate durfen nicht Gber

unsortierten Siedlungsabfall
entsorgt werden, sondern
missen getrennt gesammelt
werden.

Weitere Informationen siehe
Seite 11.

Warnung vor Laserstrahl
Produkte mit Laser sind je nach
ihrer Laser-Klasse mit genormten
Warnhinweisen versehen.
Laser kénnen aufgrund der
Eigenschaften ihrer Strahlung
und aufgrund ihrer extrem
konzentrierten
elektromagnetischen Leistung
biologische Schaden
verursachen.

Fir zuséatzliche Informationen
siehe Kapitel ,Betrieb” Punkt 7.
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Grundlegende Sicherheitshinweise

Signalworte und ihre Bedeutung

Die folgenden Signalworte werden in der Produktdokumentation verwendet, um
vor Risiken und Gefahren zu warnen.

A GEFAHR kennzeichnet eine unmittelbare Gefahrdung mit hohem
Risiko, die Tod oder schwere Korperverletzung zur Folge

haben wird, wenn sie nicht vermieden wird.

kennzeichnet eine mogliche Gefahrdung mit mittlerem
Risiko, die Tod oder (schwere) Kérperverletzung zur Folge
haben kann, wenn sie nicht vermieden wird.

A WARNUNG

kennzeichnet eine Gefahrdung mit geringem Risiko, die
leichte oder mittlere Korperverletzungen zur Folge haben
kénnte, wenn sie nicht vermieden wird.

A VORSICHT

m weist auf die Moglichkeit einer Fehlbedienung hin, bei der
das Produkt Schaden nehmen kann.

Diese Signalworte entsprechen der im europaischen Wirtschaftsraum tblichen
Definition fur zivile Anwendungen. Neben dieser Definition kénnen in anderen
Wirtschaftsraumen oder bei militarischen Anwendungen abweichende
Definitionen existieren. Es ist daher darauf zu achten, dass die hier
beschriebenen Signalworte stets nur in Verbindung mit der zugehérigen
Produktdokumentation und nur in Verbindung mit dem zugehdérigen Produkt
verwendet werden. Die Verwendung von Signalworten in Zusammenhang mit
nicht zugehdrigen Produkten oder nicht zugehorigen Dokumentationen kann zu
Fehlinterpretationen fuhren und damit zu Personen- oder Sachschaden fuhren.

Betriebszustande und Betriebslagen

Das Produkt darf nur in den vom Hersteller angegebenen Betriebszustanden und
Betriebslagen ohne Behinderung der Bellftung betrieben werden. Werden die
Herstellerangaben nicht eingehalten, kann dies elektrischen Schlag, Brand
und/oder schwere Verletzungen von Personen, unter Umstanden mit Todesfolge,
verursachen. Bei allen Arbeiten sind die ortlichen bzw. landesspezifischen
Sicherheits- und Unfallverhitungsvorschriften zu beachten.

1. Sofern nicht anders vereinbart, gilt fir R&S-Produkte folgendes:
als vorgeschriebene Betriebslage grundsatzlich Gehduseboden unten, IP-
Schutzart 2X, Verschmutzungsgrad 2, Uberspannungskategorie 2, nur in
Innenrdumen verwenden, Betrieb bis 2000 m . NN, Transport bis 4500 m a.
NN, fur die Nennspannung gilt eine Toleranz von +10%, fur die Nennfrequenz
eine Toleranz von +5%.
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2. Stellen Sie das Produkt nicht auf Oberflachen, Fahrzeuge, Ablagen oder
Tische, die aus Gewichts- oder Stabilitatsgriinden nicht daflir geeignet sind.
Folgen Sie bei Aufbau und Befestigung des Produkts an Gegenstanden oder
Strukturen (z.B. Wande und Regale) immer den Installationshinweisen des
Herstellers. Bei Installation abweichend von der Produktdokumentation
kénnen Personen verletzt, unter Umstanden sogar getotet werden.

3. Stellen Sie das Produkt nicht auf hitzeerzeugende Gerétschaften (z.B. Radia-
toren und Heizlufter). Die Umgebungstemperatur darf nicht die in der
Produktdokumentation oder im Datenblatt spezifizierte Maximaltemperatur
uberschreiten. Eine Uberhitzung des Produkts kann elektrischen Schlag,
Brand und/oder schwere Verletzungen von Personen, unter Umstanden mit
Todesfolge, verursachen.

Elektrische Sicherheit

Werden die Hinweise zur elektrischen Sicherheit nicht oder unzureichend
beachtet, kann dies elektrischen Schlag, Brand und/oder schwere Verletzungen
von Personen, unter Umstadnden mit Todesfolge, verursachen.

1. Vor jedem Einschalten des Produkts ist sicherzustellen, dass die am Produkt
eingestellte Nennspannung und die Netznennspannung des
Versorgungsnetzes ubereinstimmen. Ist es erforderlich, die Spannungs-
einstellung zu andern, so muss ggf. auch die dazu gehorige Netzsicherung
des Produkts geandert werden.

2. Bei Produkten der Schutzklasse | mit beweglicher Netzzuleitung und Geréate-
steckvorrichtung ist der Betrieb nur an Steckdosen mit Schutzkontakt und
angeschlossenem Schutzleiter zul&ssig.

3. Jegliche absichtliche Unterbrechung des Schutzleiters, sowohl in der Zuleitung
als auch am Produkt selbst, ist unzulassig. Es kann dazu flhren, dass von
dem Produkt die Gefahr eines elektrischen Schlags ausgeht. Bei Verwendung
von Verlangerungsleitungen oder Steckdosenleisten ist sicherzustellen, dass
diese regelmanig auf ihren sicherheitstechnischen Zustand tberprift werden.
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. Sofern das Produkt nicht mit einem Netzschalter zur Netztrennung
ausgerustet ist, beziehungsweise der vorhandene Netzschalter zu
Netztrennung nicht geeignet ist, so ist der Stecker des Anschlusskabels als
Trennvorrichtung anzusehen.

Die Trennvorrichtung muss jederzeit leicht erreichbar und gut zugénglich sein.
Ist z.B. der Netzstecker die Trennvorrichtung, darf die LaAnge des
Anschlusskabels 3 m nicht Gberschreiten.

Funktionsschalter oder elektronische Schalter sind zur Netztrennung nicht
geeignet. Werden Produkte ohne Netzschalter in Gestelle oder Anlagen
integriert, so ist die Trennvorrichtung auf Anlagenebene zu verlagern.

. Benutzen Sie das Produkt niemals, wenn das Netzkabel beschéadigt ist.
Uberprifen Sie regelmaRig den einwandfreien Zustand der Netzkabel. Stellen
Sie durch geeignete Schutzmaflinahmen und Verlegearten sicher, dass das
Netzkabel nicht beschadigt werden kann und niemand z.B. durch Stolperfallen
oder elektrischen Schlag zu Schaden kommen kann.

. Der Betrieb ist nur an TN/TT Versorgungsnetzen gestattet, die mit hbchstens
16 A abgesichert sind (h6here Absicherung nur nach Rucksprache mit der
Rohde & Schwarz Firmengruppe).

. Stecken Sie den Stecker nicht in verstaubte oder verschmutzte Steckdosen/-
buchsen. Stecken Sie die Steckverbindung/-vorrichtung fest und vollstandig in
die dafuir vorgesehenen Steckdosen/-buchsen. Missachtung dieser Mal3-
nahmen kann zu Funken, Feuer und/oder Verletzungen fuhren.

. Uberlasten Sie keine Steckdosen, Verlangerungskabel oder Steckdosen-
leisten, dies kann Feuer oder elektrische Schlage verursachen.

. Bei Messungen in Stromkreisen mit Spannungen Ueff > 30 V ist mit
geeigneten MalRnahmen Vorsorge zu treffen, dass jegliche Gefahrdung
ausgeschlossen wird (z.B. geeignete Messmittel, Absicherung,
Strombegrenzung, Schutztrennung, Isolierung usw.).

10.Bei Verbindungen mit informationstechnischen Geréten, z.B. PC oder

Industrierechner, ist darauf zu achten, dass diese der jeweils gultigen IEC
60950-1 / EN 60950-1 oder IEC 61010-1 / EN 61010-1 entsprechen.

11.Sofern nicht ausdricklich erlaubt, darf der Deckel oder ein Teil des Gehauses

niemals entfernt werden, wenn das Produkt betrieben wird. Dies macht
elektrische Leitungen und Komponenten zugénglich und kann zu
Verletzungen, Feuer oder Schaden am Produkt fihren.

1171.0000.51 - 08 Seite 6
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12.Wird ein Produkt ortsfest angeschlossen, ist die Verbindung zwischen dem
Schutzleiteranschluss vor Ort und dem Gerateschutzleiter vor jeglicher
anderer Verbindung herzustellen. Aufstellung und Anschluss darf nur durch
eine Elektrofachkraft erfolgen.

13.Bei ortsfesten Geraten ohne eingebaute Sicherung, Selbstschalter oder
ahnliche Schutzeinrichtung muss der Versorgungskreis so abgesichert sein,
dass alle Personen, die Zugang zum Produkt haben, sowie das Produkt selbst
ausreichend vor Schaden geschutzt sind.

14.Jedes Produkt muss durch geeigneten Uberspannungsschutz vor Uber-
spannung (z.B. durch Blitzschlag) geschiitzt werden. Andernfalls ist das
bedienende Personal durch elektrischen Schlag gefahrdet.

15.Gegenstande, die nicht dafiir vorgesehen sind, dirfen nicht in die Offnungen
des Gehauses eingebracht werden. Dies kann Kurzschlisse im Produkt
und/oder elektrische Schlage, Feuer oder Verletzungen verursachen.

16.Sofern nicht anders spezifiziert, sind Produkte nicht gegen das Eindringen von
Fllssigkeiten geschutzt, siehe auch Abschnitt "Betriebszustande und
Betriebslagen”, Punkt 1. Daher missen die Gerate vor Eindringen von
Flissigkeiten geschitzt werden. Wird dies nicht beachtet, besteht Gefahr
durch elektrischen Schlag fur den Benutzer oder Beschadigung des Produkts,
was ebenfalls zur Gefahrdung von Personen fiihren kann.

17.Benutzen Sie das Produkt nicht unter Bedingungen, bei denen Kondensation
in oder am Produkt stattfinden kdnnte oder ggf. bereits stattgefunden hat, z.B.
wenn das Produkt von kalter in warme Umgebung bewegt wurde. Das
Eindringen von Wasser erhtht das Risiko eines elektrischen Schlages.

18.Trennen Sie das Produkt vor der Reinigung komplett von der
Energieversorgung (z.B. speisendes Netz oder Batterie). Nehmen Sie bei
Geraten die Reinigung mit einem weichen, nicht fasernden Staublappen vor.
Verwenden Sie keinesfalls chemische Reinigungsmittel wie z.B. Alkohol,
Aceton, Nitroverdiinnung.

Betrieb

1. Die Benutzung des Produkts erfordert spezielle Einweisung und hohe
Konzentration wéahrend der Benutzung. Es muss sichergestellt sein, dass
Personen, die das Produkt bedienen, bezuglich ihrer koérperlichen, geistigen
und seelischen Verfassung den Anforderungen gewachsen sind, da
andernfalls Verletzungen oder Sachschaden nicht auszuschliel3en sind. Es
liegt in der Verantwortung des Arbeitsgebers/Betreibers, geeignetes Personal
fur die Benutzung des Produkts auszuwéhlen.
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Grundlegende Sicherheitshinweise

2. Bevor Sie das Produkt bewegen oder transportieren, lesen und beachten Sie
den Abschnitt "Transport".

3. Wie bei allen industriell gefertigten Gutern kann die Verwendung von Stoffen,
die Allergien hervorrufen - so genannte Allergene (z.B. Nickel) - nicht generell
ausgeschlossen werden. Sollten beim Umgang mit R&S-Produkten allergische
Reaktionen, z.B. Hautausschlag, haufiges Niesen, Bindehautrétung oder
Atembeschwerden auftreten, ist umgehend ein Arzt aufzusuchen, um die
Ursachen zu klaren und Gesundheitsschaden bzw. -belastungen zu
vermeiden.

4. Vor der mechanischen und/oder thermischen Bearbeitung oder Zerlegung des
Produkts beachten Sie unbedingt Abschnitt "Entsorgung”, Punkt 1.

5. Bei bestimmten Produkten, z.B. HF-Funkanlagen, kdnnen funktionsbedingt
erhohte elektromagnetische Strahlungen auftreten. Unter Berticksichtigung
der erh6hten Schutzwirdigkeit des ungeborenen Lebens missen Schwangere
durch geeignete MalRnahmen geschutzt werden. Auch Trager von
Herzschrittmachern kénnen durch elektromagnetische Strahlungen gefahrdet
sein. Der Arbeitgeber/Betreiber ist verpflichtet, Arbeitsstatten, bei denen ein
besonderes Risiko einer Strahlenexposition besteht, zu beurteilen und zu
kennzeichnen und maogliche Gefahren abzuwenden.

6. Im Falle eines Brandes entweichen ggf. giftige Stoffe (Gase, Flussigkeiten
etc.) aus dem Produkt, die Gesundheitsschéaden verursachen kdnnen. Daher
sind im Brandfall geeignete Malinahmen wie z.B. Atemschutzmasken und
Schutzkleidung zu verwenden.

7. Falls ein Laser-Produkt in ein R&S-Produkt integriert ist (z.B. CD/DVD-
Laufwerk), durfen keine anderen Einstellungen oder Funktionen verwendet
werden, als in der Produktdokumentation beschrieben, um Personenschaden
zu vermeiden (z.B. durch Laserstrahl).

8. EMV Klassen (nach EN 55011 / CISPR 11; sinngemalfd EN 55022 / CISPR 22,
EN 55032 / CISPR 32)

Gerat der Klasse A:

Ein Gerat, das sich fur den Gebrauch in allen anderen Bereichen auf3er dem
Wohnbereich und solchen Bereichen eignet, die direkt an ein
Niederspannungs-Versorgungsnetz angeschlossen sind, das Wohngebaude
versorgt.

Hinweis: Diese Einrichtung kann wegen mdoglicher auftretender
leitungsgebundener als auch gestrahlten StérgréRen im Wohnbereich
Funkstorungen verursachen. In diesem Fall kann vom Betreiber verlangt
werden, angemessene Mal3nahmen durchzufihren.
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Gerat der Klasse B:

Ein Gerat, das sich fur den Betrieb im Wohnbereich sowie in solchen
Bereichen eignet, die direkt an ein Niederspannungs-Versorgungsnetz
angeschlossen sind, das Wohngebaude versorgt.

Reparatur und Service

1.

Das Produkt darf nur von daflir autorisiertem Fachpersonal geoffnet werden.
Vor Arbeiten am Produkt oder Offnen des Produkts ist dieses von der
Versorgungsspannung zu trennen, sonst besteht das Risiko eines elektrischen
Schlages.

. Abgleich, Auswechseln von Teilen, Wartung und Reparatur darf nur von R&S-

autorisierten Elektrofachkraften ausgefiihrt werden. Werden sicherheits-
relevante Teile (z.B. Netzschalter, Netztrafos oder Sicherungen) aus-
gewechselt, so diurfen diese nur durch Originalteile ersetzt werden. Nach
jedem Austausch von sicherheitsrelevanten Teilen ist eine Sicherheitsprifung
durchzufiihren (Sichtprifung, Schutzleitertest, Isolationswiderstand-,
Ableitstrommessung, Funktionstest). Damit wird sichergestellt, dass die
Sicherheit des Produkts erhalten bleibt.

Batterien und Akkumulatoren/Zellen

Werden die Hinweise zu Batterien und Akkumulatoren/Zellen nicht oder
unzureichend beachtet, kann dies Explosion, Brand und/oder schwere
Verletzungen von Personen, unter Umstanden mit Todesfolge, verursachen. Die
Handhabung von Batterien und Akkumulatoren mit alkalischen Elektrolyten (z.B.
Lithiumzellen) muss der EN 62133 entsprechen.

1.
2.

Zellen durfen nicht zerlegt, getffnet oder zerkleinert werden.

Zellen oder Batterien durfen weder Hitze noch Feuer ausgesetzt werden. Die
Lagerung im direkten Sonnenlicht ist zu vermeiden. Zellen und Batterien
sauber und trocken halten. Verschmutzte Anschlisse mit einem trockenen,
sauberen Tuch reinigen.

Zellen oder Batterien durfen nicht kurzgeschlossen werden. Zellen oder
Batterien durfen nicht gefahrbringend in einer Schachtel oder in einem
Schubfach gelagert werden, wo sie sich gegenseitig kurzschliel3en oder durch
andere leitende Werkstoffe kurzgeschlossen werden kdnnen. Eine Zelle oder
Batterie darf erst aus ihrer Originalverpackung entnommen werden, wenn sie
verwendet werden soll.

Zellen oder Batterien dirfen keinen unzuldssig starken, mechanischen St63en
ausgesetzt werden.
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Grundlegende Sicherheitshinweise

Bei Undichtheit einer Zelle darf die Flussigkeit nicht mit der Haut in Berihrung
kommen oder in die Augen gelangen. Falls es zu einer Beriihrung gekommen
ist, den betroffenen Bereich mit reichlich Wasser waschen und arztliche Hilfe
in Anspruch nehmen.

Werden Zellen oder Batterien, die alkalische Elektrolyte enthalten (z.B.
Lithiumzellen), unsachgemald ausgewechselt oder geladen, besteht
Explosionsgefahr. Zellen oder Batterien nur durch den entsprechenden R&S-
Typ ersetzen (siehe Ersatzteilliste), um die Sicherheit des Produkts zu
erhalten.

Zellen oder Batterien missen wiederverwertet werden und dirfen nicht in den
Restmll gelangen. Akkumulatoren oder Batterien, die Blei, Quecksilber oder
Cadmium enthalten, sind Sonderabfall. Beachten Sie hierzu die landes-
spezifischen Entsorgungs- und Recycling-Bestimmungen.

Transport

1.

Das Produkt kann ein hohes Gewicht aufweisen. Daher muss es vorsichtig
und ggf. unter Verwendung eines geeigneten Hebemittels (z.B. Hubwagen)
bewegt bzw. transportiert werden, um Rickenschaden oder Verletzungen zu
vermeiden.

Griffe an den Produkten sind eine Handhabungshilfe, die ausschliellich fur
den Transport des Produkts durch Personen vorgesehen ist. Es ist daher nicht
zuldssig, Griffe zur Befestigung an bzw. auf Transportmitteln, z.B. Kranen,
Gabelstaplern, Karren etc. zu verwenden. Es liegt in lhrer Verantwortung, die
Produkte sicher an bzw. auf geeigneten Transport- oder Hebemitteln zu
befestigen. Beachten Sie die Sicherheitsvorschriften des jeweiligen Herstellers
eingesetzter Transport- oder Hebemittel, um Personenschaden und Schaden
am Produkt zu vermeiden.

Falls Sie das Produkt in einem Fahrzeug benutzen, liegt es in der alleinigen
Verantwortung des Fahrers, das Fahrzeug in sicherer und angemessener
Weise zu fuhren. Der Hersteller ibernimmt keine Verantwortung fir Unfélle
oder Kollisionen. Verwenden Sie das Produkt niemals in einem sich bewe-
genden Fahrzeug, sofern dies den Fahrzeugftihrer ablenken kdnnte. Sichern
Sie das Produkt im Fahrzeug ausreichend ab, um im Falle eines Unfalls
Verletzungen oder Schéaden anderer Art zu verhindern.

1171.0000.51 - 08 Seite 10



Grundlegende Sicherheitshinweise

Entsorgung

1.

Batterien bzw. Akkumulatoren, die nicht mit dem Hausmiuill entsorgt werden
durfen, darf nach Ende der Lebensdauer nur tiber eine geeignete
Sammelstelle oder eine Rohde & Schwarz-Kundendienststelle entsorgt
werden.

Am Ende der Lebensdauer des Produktes darf dieses Produkt nicht Gber den
normalen Hausmdll entsorgt werden, sondern muss getrennt gesammelt
werden.

Rohde & Schwarz GmbH & Co.KG ein Entsorgungskonzept entwickelt und
tbernimmt die Pflichten der Riicknahme- und Entsorgung fur Hersteller
innerhalb der EU in vollem Umfang. Wenden Sie sich bitte an Ihre

Rohde & Schwarz-Kundendienststelle, um das Produkt umweltgerecht zu
entsorgen.

Werden Produkte oder ihre Bestandteile Uber den bestimmungsgemalien
Betrieb hinaus mechanisch und/oder thermisch bearbeitet, kdnnen ggf.
gefahrliche Stoffe (schwermetallhaltiger Staub wie z.B. Blei, Beryllium, Nickel)
freigesetzt werden. Die Zerlegung des Produkts darf daher nur von speziell
geschultem Fachpersonal erfolgen. Unsachgemal3es Zerlegen kann
Gesundheitsschaden hervorrufen. Die nationalen Vorschriften zur Entsorgung
sind zu beachten.

Falls beim Umgang mit dem Produkt Gefahren- oder Betriebsstoffe entstehen,
die speziell zu entsorgen sind, z.B. regelmalig zu wechselnde Kuhimittel oder
Motorendle, sind die Sicherheitshinweise des Herstellers dieser Gefahren-
oder Betriebsstoffe und die regional gultigen Entsorgungsvorschriften
einzuhalten. Beachten Sie ggf. auch die zugehorigen speziellen
Sicherheitshinweise in der Produktdokumentation. Die unsachgemalfie
Entsorgung von Gefahren- oder Betriebsstoffen kann zu Gesundheitsschaden
von Personen und Umweltschaden fuhren.

Weitere Informationen zu Umweltschutz finden Sie auf der Rohde & Schwarz
Home Page.
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Consignes de sécurité fondamentales

Lisez et respectez impérativement les instructions et consignes de sécurité
suivantes

Les usines et sites du groupe Rohde & Schwarz veillent a la conformité des
produits du groupe avec les normes de sécurité en vigueur dans un souci
constant de garantir aux clients le plus haut niveau de sécurité possible. Nos
produits ainsi que les accessoires nécessaires sont fabriqués et testés
conformément aux regles de sécurité en vigueur. Le respect de ces régles est
vérifié régulierement par notre systéme d’assurance qualité. Le présent produit a
été fabriqué et contrdlé conformément au certificat de conformité CE ci-joint et a
quitté l'usine dans un parfait état de sécurité. Pour le maintenir dans cet état et en
garantir une utilisation sans danger, l'utilisateur doit respecter I'ensemble des
consignes, remarques de sécurité et avertissements qui se trouvent dans ce
manuel. Le groupe Rohde & Schwarz se tient a votre disposition pour toutes
guestions relatives aux présentes consignes de sécurité.

Il incombe a l'utilisateur d’employer ce produit de maniere appropriée. Le produit
est exclusivement destiné a l'utilisation en industrie et en laboratoire et/ou, si cela
a été expressément autorisé, également aux travaux extérieurs ; il ne peut en
aucun cas étre utilisé a des fins pouvant causer des dommages corporels ou
matériels. L’exploitation du produit en dehors de son utilisation prévue ou le non-
respect des consignes du fabricant se font sous la responsabilité de I'utilisateur.
Le fabricant décline toute responsabilité en cas d’utilisation non conforme du
produit.

Le produit est présumé faire I'objet d’'une utilisation conforme lorsqu’il est utilisé
conformément aux consignes de la documentation produit correspondante et
dans la limite de ses performances (voir fiche technique, documentation,
consignes de sécurité ci-apres). L'utilisation du produit exige des compétences
en la matiére et des connaissances de base de I'anglais. Par conséquent, le
produit ne devra étre utilisé que par un personnel qualifié ou des personnes
formées de maniere approfondie et possédant les compétences requises. Si,
pour l'utilisation des produits Rohde & Schwarz, 'emploi d’'un équipement
personnel de protection s’avere nécessaire, il en est fait mention dans la
documentation produit a 'emplacement correspondant. Conservez les consignes
de sécurité fondamentales et la documentation produit dans un lieu sir et
transmettez ces documents aux autres utilisateurs du produit.
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Consignes de sécurité fondamentales

La stricte observation des consignes de sécurité a pour but d’exclure des
blessures ou dommages causés par des dangers de toutes sortes. A cet effet, il
est nécessaire de lire avec soin et de bien comprendre les consignes de sécurité
ci-dessous avant l'utilisation du produit et de les respecter lors de I'utilisation du

produit. Toutes les autres consignes de sécurité présentées a I'emplacement
correspondant de la documentation produit, par exemple, celles concernant la
protection des personnes, doivent également étre impérativement respectées.
Dans les présentes consignes de sécurité, toutes les marchandises
commercialisées par le groupe Rohde & Schwarz, notamment les appareils, les
systémes ainsi que les accessoires, sont dénommes « produit ».

Symboles et marquages de sécurité

Symbole | Signification Symbole | Signification
VA Avis, source générale de danger | O MARCHE / ARRET (tension
' ver s . d’alimentation)
Se référer a la documentation
| produit
Attention lors de la manipulation @ Indicateur de veille
A d’appareils ayant un poids élevé
| 18 ko |
f Risque de choc électrique —— Courant continu (CC)
2 Avertissement, surface chaude ~ Courant alternatif (CA)
Borne de conducteur de protection ~= | Courant continu/alternatif (CC/CA)
I Borne de mise a la terre ] L’appareil est conforme aux
- exigences de sécurité du degré de
= protection Il
(appareil entierement protégé par
isolation double/renforcée).
Borne de mise a la masse du bati Marguage UE pour batteries et
ou du boitier accumulateurs.

L’appareil contient une batterie ou
un accumulateur. Ces piéces ne
peuvent pas étre éliminées avec
les déchets urbains non triés,
mais doivent faire 'objet d’une
collecte séparée.

Pour plus d’'informations, voir la
page 7.
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Symbole

Signification

Symbole

Signification

Avis : prudence lors de la
manipulation de composants
sensibles aux décharges
électrostatiques

Marguage UE pour la collecte
séparée d’équipements
électriques et électroniques.

Les déchets d’équipements
électriques et électroniques ne
peuvent pas étre éliminés avec les
déchets urbains non triés, mais
doivent faire I'objet d’'une collecte
séparée.

Pour plus d’'informations, voir la
page 7.

Avertissement, rayon laser

Les produits laser sont munis
d’avertissements normalisés
d’apres leur catégorie laser.

En raison des caractéristiques de
leur rayonnement ainsi que de
leur puissance électromagnétique
extrémement concentrée, les
lasers peuvent causer des
dommages biologiques.

Pour plus d’informations, voir le
chapitre « Fonctionnement »",
point 7.
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Mots d’alerte et significations

Les mots d’alerte suivants sont utilisés dans la documentation produit pour avertir
des risques et dangers.

A DANGER Indique une situation dangereuse immeédiate qui, Si

elle n'est pas évitée, comporte un risque élevé de
blessures graves ou mortelles.

Indigue une situation dangereuse possible qui, si
elle n'est pas évitée, comporte un risque modéré
de blessures (graves) ou mortelles.

A AVERTISSEMENT

Indique une situation dangereuse qui, si elle n’est
pas évitée, comporte un risque faible de blessures
mineures ou modérées.

A ATTENTION

m Indique la possibilité d’'une fausse manceuvre
susceptible d'endommager le produit.

Ces mots d’alerte correspondent a la définition habituelle utilisée pour des
applications civiles dans I'espace économique européen. Des définitions
divergentes peuvent cependant exister dans d’autres espaces économiques ou
dans le cadre d’applications militaires. Il faut donc veiller a ce que les mots
d’alerte décrits ici ne soient utilisés qu’en relation avec la documentation produit
correspondante et seulement avec le produit correspondant. L'utilisation des
mots d’alerte en relation avec des produits ou des documentations non
correspondants peut conduire a des erreurs d’interprétation et par conséquent a
des dommages corporels ou matériels.
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Etats et positions de fonctionnement

L’appareil ne doit étre utilisé que dans les états et positions de fonctionnement
indiqués par le fabricant. Tout obstacle a la ventilation doit étre empéché. Le non-
respect des indications du fabricant peut provoquer des chocs électriques, des
incendies et/ou des blessures graves pouvant éventuellement entrainer la mort.
Pour tous les travaux, les regles locales et/ou nationales de sécurité et de
prévention des accidents doivent étre respectées.

1. Sauf stipulations contraires, les produits Rohde & Schwarz répondent aux
exigences ci-apres :
faire fonctionner le produit avec le fond du boitier toujours en bas, degré de
protection IP 2X, degré de pollution 2, catégorie de surtension 2, utilisation
uniguement a l'intérieur, fonctionnement a une altitude max. de 2000 m au-
dessus du niveau de la mer, transport a une altitude max. de 4500 m au-
dessus du niveau de la mer, tolérance de +10 % pour la tension nominale et
de =5 % pour la fréquence nominale.

2. Ne jamais placer le produit sur des surfaces, véhicules, dépoéts ou tables non
appropriés pour raisons de stabilité ou de poids. Suivre toujours strictement
les indications d’installation du fabricant pour le montage et la fixation du
produit sur des objets ou des structures (par exemple parois et étagéres). En
cas d’installation non conforme a la documentation produit, il y a risque de
blessures, voire de mort.

3. Ne jamais placer le produit sur des dispositifs générant de la chaleur (par
exemple radiateurs et appareils de chauffage soufflants). La température
ambiante ne doit pas dépasser la température maximale spécifiée dans la
documentation produit ou dans la fiche technique. Une surchauffe du produit
peut provoquer des chocs électriques, des incendies et/ou des blessures
graves pouvant éventuellement entrainer la mort.

Sécurité électrique

Si les consignes relatives a la sécurité électrique ne sont pas ou sont
insuffisamment respectées, il peut s’ensuivre des chocs électriques, des
incendies et/ou des blessures graves pouvant éventuellement entrainer la mort.

1. Avant chague mise sous tension du produit, il faut s’assurer que la tension
nominale réglée sur le produit correspond a la tension nominale du réseau
electrique. S'il est nécessaire de modifier le réglage de la tension, il faut
remplacer le fusible du produit, le cas échéant.

2. L'utilisation des produits du degré de protection | pourvus d’'un céble
d’alimentation mobile et d’'un connecteur n’est autorisée qu’avec des prises
munies d’'un contact de protection et d’'un conducteur de protection raccordé.
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3. Toute déconnexion intentionnelle du conducteur de protection, dans le cable
ou dans le produit lui-méme, est interdite. Elle entraine un risque de choc
électrique au niveau du produit. En cas d’utilisation de cables prolongateurs
ou de multiprises, ceux-ci doivent étre examinés régulierement quant a leur
état de sécurité technique.

4. Sile produit n’est pas doté d’un interrupteur d’alimentation pour le couper du
réseau électrique ou si l'interrupteur d’alimentation disponible n’est pas
approprié pour couper le produit du réseau électrique, le connecteur male du
cable de raccordement est a considérer comme dispositif de séparation.

Le dispositif de séparation doit étre a tout moment facilement accessible. Si,
par exemple, le connecteur d’alimentation sert de dispositif de séparation, la
longueur du céble de raccordement ne doit pas dépasser 3 m.

Les commutateurs fonctionnels ou électroniqgues ne sont pas appropriés pour
couper I'appareil du réseau électrique. Si des produits sans interrupteur
d’alimentation sont intégrés dans des batis ou systemes, le dispositif de
séparation doit étre reporté au niveau du systeme.

5. Ne jamais utiliser le produit si le cable d’alimentation est endommagé. Vérifier
régulierement le parfait état du cable d’alimentation. Prendre les mesures
préventives appropriées et opter pour des types de pose tels que le cable
d’alimentation ne puisse pas étre endommageé et que personne ne puisse
subir de préjudice, par exemple en trébuchant sur le cable ou par des chocs
électriques.

6. L'utilisation des produits est uniqguement autorisée sur des réseaux
d’alimentation de type TN/TT protégés par des fusibles d’'une intensité max.
de 16 A (pour toute intensité supérieure, consulter le groupe

Rohde & Schwarz).

7. Ne pas brancher le connecteur dans des prises d’alimentation sales ou
poussiéreuses. Enfoncer fermement le connecteur jusqu’au bout de la prise.
Le non-respect de cette mesure peut provoquer des étincelles, incendies et/ou
blessures.

8. Ne pas surcharger les prises, les cables prolongateurs ou les multiprises, cela
pouvant provoquer des incendies ou chocs électriques.

9. En cas de mesures sur les circuits électriques d’une tension efficace > 30 V,
prendre les précautions nécessaires pour éviter tout risque (par exemple
equipement de mesure appropri€, fusibles, limitation de courant, coupe-circuit,
isolation, etc.).
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10.En cas d’interconnexion avec des équipements informatiques comme par
exemple un PC ou un ordinateur industriel, veiller & ce que ces derniers soient
conformes aux normes IEC 60950-1 / EN 60950-1 ou IEC 61010-1/ EN
61010-1 en vigueur.

11.Sauf autorisation expresse, il est interdit de retirer le couvercle ou toute autre
piece du boitier lorsque le produit est en cours de service. Les cables et
composants électriques seraient ainsi accessibles, ce qui peut entrainer des
blessures, des incendies ou des dégats sur le produit.

12.Si un produit est connecté de facon stationnaire, établir avant toute autre
connexion le raccordement du conducteur de protection local et du conducteur
de protection du produit. L'installation et le raccordement ne peuvent étre
effectués que par un électricien ou électronicien qualifié.

13.Sur les appareils stationnaires sans fusible ni disjoncteur automatique ou
dispositif de protection similaire intégrés, le circuit d’alimentation doit étre
sécurisé de sorte que toutes les personnes ayant acces au produit et le
produit lui-méme soient suffisamment protégés contre tout dommage.

14.Chaque produit doit étre protégé de maniere appropriée contre les éventuelles
surtensions (par exemple dues a un coup de foudre). Sinon, les utilisateurs
sont exposeés a des risques de choc électrique.

15.Ne jamais introduire d’objets non prévus a cet effet dans les ouvertures du
boitier, étant donné que cela peut entrainer des courts-circuits dans le produit
et/ou des chocs électriques, incendies ou blessures.

16.Sauf spécification contraire, les produits ne sont pas protégés contre
linfiltration de liquides, voir aussi la section « Etats et positions de
fonctionnement », point 1. Il faut donc protéger les produits contre I'infiltration
de liquides. La non-observation de cette consigne entraine le risque de choc
électrique pour l'utilisateur ou d’endommagement du produit, ce qui peut
également mettre les personnes en danger.

17.Ne pas utiliser le produit dans des conditions pouvant occasionner ou ayant
déja occasionné, le cas échéant, des condensations dans ou sur le produit,
par exemple lorsque celui-ci est déplacé d’un environnement froid dans un
environnement chaud. L'infiltration d’eau augmente le risque de choc
électrique.

18.Avant le nettoyage, débrancher le produit de I'alimentation (par exemple
réseau €électrique ou batterie). Pour le nettoyage des appareils, utiliser un
chiffon doux non pelucheux. N’utiliser en aucun cas de produit de nettoyage
chimique, tel que de l'alcool, de I'acétone ou un diluant nitrocellulosique.
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Fonctionnement

1.

L’utilisation du produit exige une formation spécifique ainsi qu’une grande
concentration. Il est impératif que les personnes qui utilisent le produit présent
les aptitudes physiques, mentales et psychiques requises, vu qu’autrement
des dommages corporels ou matériels ne peuvent pas étre exclus. Le choix
du personnel qualifié pour l'utilisation du produit est sous la responsabilité de
I'employeur/I'exploitant.

. Avant de déplacer ou de transporter le produit, lire et respecter la section

« Transport ».

Comme pour tous les biens produits de fagon industrielle, I'utilisation de
matériaux pouvant causer des allergies (allergénes, comme par exemple le
nickel) ne peut étre totalement exclue. Si, lors de l'utilisation de produits
Rohde & Schwarz, des réactions allergiques surviennent, telles qu’éruption
cutanée, éternuements fréquents, rougeur de la conjonctive ou difficultés
respiratoires, il faut immédiatement consulter un médecin pour en clarifier la
cause et éviter toute atteinte a la sante.

Avant le traitement mécanique et/ou thermique ou le démontage du produit, il
faut impérativement observer la section « Elimination des déchets », point 1.

Selon les fonctions, certains produits, tels que des systemes de
radiocommunication RF, peuvent produire des niveaux élevés de
rayonnement électromagnétique. Etant donné la vulnérabilité de I'enfant &
naitre, les femmes enceintes doivent étre protégées par des mesures
appropriées. Les porteurs de stimulateurs cardiaques peuvent également étre
menaces par les rayonnements électromagnétiques. L’employeur/I'exploitant
est tenu d’évaluer et de repérer les lieux de travail soumis a un risque
particulier d’exposition aux rayonnements et de prévenir les dangers
éeventuels.

En cas d’incendie, il se peut que le produit dégage des matieres toxiques
(gaz, liquides, etc.) susceptibles de nuire a la santé. Il faut donc, en cas
d’incendie, prendre des mesures adéquates comme par exemple le port de
masques respiratoires et de vétements de protection.

. Si un produit laser est intégré dans un produit Rohde & Schwarz (par exemple

lecteur CD/DVD), il ne faut pas utiliser de réglages ou fonctions autres que
ceux décrits dans la documentation produit pour éviter tout dommage corporel
(par exemple causeé par rayon laser).

Classes CEM (selon EN 55011 / CISPR 11 ; selon EN 55022 / CISPR 22, EN
55032 / CISPR 32 par analogie)
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— Appareil de laclasse A:
Appareil approprié a un usage dans tous les environnements autres que
I'environnement résidentiel et les environnements raccordés directement a
un réseau d’alimentation basse tension qui alimente des batiments
résidentiels.
Remargue : ces appareils peuvent provoquer des perturbations
radioélectriques dans I'environnement résidentiel en raison de
perturbations conduites ou rayonnées. Dans ce cas, on peut exiger que
I'exploitant mette en ceuvre de mesures appropriées pour éliminer ces
perturbations.

— Appareil delaclasseB :
Appareil approprié a un usage dans I'environnement résidentiel ainsi que
dans les environnements raccordés directement a un réseau d’alimentation
basse tension qui alimente des batiments résidentiels.

Réparation et service apres-vente

1. Le produit ne doit étre ouvert que par un personnel qualifié et autorisé. Avant
de travailler sur le produit ou de I'ouvrir, il faut le couper de la tension
d’alimentation ; sinon il y a risque de choc électrique.

2. Les travaux d’ajustement, le remplacement des pieces, la maintenance et la
réparation ne doivent étre effectués que par des électroniciens qualifiés et
autorisés par Rohde & Schwarz. En cas de remplacement de piéces
concernant la sécurité (notamment interrupteur d’alimentation, transformateur
d’alimentation réseau ou fusibles), celles-ci ne doivent étre remplacées que
par des pieces d’origine. Apres chaque remplacement de pieces concernant la
sécurité, une vérification de sécurité doit étre effectuée (contrdle visuel,
vérification du conducteur de protection, mesure de la résistance d’isolement
et du courant de fuite, essai de fonctionnement). Cela permet d’assurer le
maintien de la sécurité du produit.

Batteries et accumulateurs/cellules

Si les instructions concernant les batteries et accumulateurs/cellules ne sont pas
ou sont insuffisamment respectées, cela peut provoquer des explosions, des
incendies et/ou des blessures graves pouvant entrainer la mort. La manipulation
de batteries et accumulateurs contenant des électrolytes alcalins (par exemple
cellules de lithium) doit étre conforme a la norme EN 62133.

1. Les cellules ne doivent étre ni démontées, ni ouvertes, ni réduites en
morceaux.
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2. Ne jamais exposer les cellules ou batteries a la chaleur ou au feu. Ne pas les
stocker dans un endroit ou elles sont exposées au rayonnement direct du
soleil. Tenir les cellules et batteries au sec. Nettoyer les raccords sales avec
un chiffon sec et propre.

3. Ne jamais court-circuiter les cellules ou batteries. Les cellules ou batteries ne
doivent pas étre gardées dans une boite ou un tiroir ou elles peuvent se court-
circuiter mutuellement ou étre court-circuitées par d’autres matériaux
conducteurs. Une cellule ou batterie ne doit étre retirée de son emballage
d’origine que lorsqu’on l'utilise.

4. Les cellules ou batteries ne doivent pas étre exposées a des chocs
mécaniqgues de force non admissible.

5. En cas de manque d’étanchéité d’une cellule, le liquide ne doit pas entrer en
contact avec la peau ou les yeux. S’il y a contact, rincer abondamment a I'eau
I'endroit concerné et consulter un meédecin.

6. Il y a danger d’explosion en cas de remplacement ou chargement incorrect
des cellules ou batteries qui contiennent des électrolytes alcalins (par exemple
cellules de lithium). Remplacer les cellules ou batteries uniguement par le type
Rohde & Schwarz correspondant (voir la liste des piéces de rechange) pour
maintenir la sécurité du produit.

7. 1l faut recycler les cellules ou batteries et il est interdit de les éliminer comme
déchets normaux. Les accumulateurs ou batteries qui contiennent du plomb,
du mercure ou du cadmium sont des déchets spéciaux. Observer les regles
nationales d’élimination et de recyclage.

Transport

1. Le produit peut avoir un poids élevé. Il faut donc le déplacer ou le transporter
avec précaution et en utilisant le cas échéant un moyen de levage approprié
(par exemple, chariot élévateur) pour éviter des dommages au dos ou des
blessures.

2. Les poignées des produits sont une aide de manipulation exclusivement
réservée au transport du produit par des personnes. Il est donc proscrit
d’utiliser ces poignées pour attacher le produit & ou sur des moyens de
transport, tels que grues, chariots et chariots élévateurs, etc. Vous étes
responsable de la fixation slre des produits a ou sur des moyens de transport
et de levage appropriés. Observer les consignes de sécurité du fabricant des
moyens de transport ou de levage utilisés pour éviter des dommages
corporels et des dégats sur le produit.
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3. L'utilisation du produit dans un véhicule se fait sous l'unique responsabilité du
conducteur qui doit piloter le véhicule de maniére slre et appropriée. Le
fabricant décline toute responsabilité en cas d’accidents ou de collisions. Ne
jamais utiliser le produit dans un véhicule en mouvement si cela pouvait
détourner I'attention du conducteur. Sécuriser suffisamment le produit dans le
véhicule pour empécher des blessures ou dommages de tout type en cas
d’accident.

Elimination des déchets

1. Auterme de leur durée de vie, les batteries ou accumulateurs qui ne peuvent
pas étre éliminés avec les déchets ménagers peuvent uniguement étre
éliminés par des points de collecte appropriés ou par un centre de service
aprés-vente Rohde & Schwarz.

2. Au terme de sa durée de vie, un produit ne peut pas étre éliminé avec les
déchets ménagers normaux, mais doit étre collecté séparément.
Rohde & Schwarz GmbH & Co. KG a développé un concept d’élimination des
déchets et assume toutes les obligations en matiére de reprise et
d’élimination, valables pour les fabricants au sein de 'UE. Veuillez vous
adresser a votre centre de service apres-vente Rohde & Schwarz pour
éliminer le produit de maniere écologique.

3. Siles produits ou leurs composants sont travaillés mécaniqguement et/ou
thermiquement au-dela de I'utilisation prévue, ils peuvent, le cas échéant,
libérer des substances dangereuses (poussiéres contenant des métaux lourds
comme par exemple du plomb, du béryllium ou du nickel). Le démontage du
produit ne doit donc étre effectué que par un personnel qualifié et
spécialement formé. Le démontage inadéquat peut nuire a la santé. Les
regles nationales concernant I'élimination des déchets doivent étre observées.

4. Si, lors de l'utilisation du produit, des substances dangereuses ou
combustibles exigeant une élimination spéciale sont dégagées, comme par
exemple liquides de refroidissement ou huiles moteurs qui sont a changer
régulierement, les consignes de sécurité du fabricant de ces substances
dangereuses ou combustibles ainsi que les régles sur I'élimination en vigueur
au niveau régional doivent étre respectées. Les consignes de sécurité
spéciales correspondantes dans la documentation produit doivent également
étre respectees, le cas échéant. L’élimination non conforme des substances
dangereuses ou combustibles peut provoquer des atteintes a la santé et des
dommages écologiques.

Pour plus d’'informations concernant la protection de I'environnement, voir la page
d’accueil de Rohde & Schwarz.
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Technical support — where and when you need it

For quick, expert help with any Rohde & Schwarz equipment, contact one of our Customer
Support Centers. A team of highly qualified engineers provides telephone support and will
work with you to find a solution to your query on any aspect of the operation, programming
or applications of Rohde & Schwarz equipment.

Up-to-date information and upgrades

To keep your instrument up-to-date and to be informed about new application notes related
to your instrument, please send an e-mail to the Customer Support Center stating your

instrument and your wish.

We will take care that you will get the right information.

Europe, Africa, Middle East Phone +49 89 4129 12345

North America

Latin America

Asia/Pacific

China

1171.0500.22-06.00

customersupport@rohde-schwarz.com

Phone 1-888-TEST-RSA (1-888-837-8772)
customer.support@rsa.rohde-schwarz.com

Phone +1-410-910-7988
customersupport.la@rohde-schwarz.com

Phone +6565 1304 88
customersupport.asia@rohde-schwarz.com

Phone +86-800-810-8228 /
+86-400-650-5896
customersupport.china@rohde-schwarz.com

ROHDE&SCHWARZ
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R&S®SGT100A Preface

1 Preface

The R&S SGT Vector RF Source is a signal generator intended for the generation
of IQ-modulated signals in the frequency range up to 6 GHz as well as the play-
back and output of externally calculated modulation signals in the form of wave-
forms.

Optimized for use in automated test equipment (ATE), the instrument offers very
fast settling times in an exceptionally small formfactor and low power consump-
tion. The R&S SGT is equipped with an active electronic step attenuator and can
be equipped optionally with a high stability reference oscillator.

1.1 Key Features

The key features of the R&S SGT include the following:

® Compact size and low power consumption

® Remote connection via PCI Express, minimizing time for setup
Alternatively, LAN or USB connections available

® Coherent LO input and output connectors, also usable as MIMO input/output
and phase coherent |/Q demodulation

® Linux operating system

® Graphical user interface R&S SGMA-GUI to set up and control one or more
R&S SGT instruments simultaneously from one remote computer, available
for Windows and Linux systems

1.2 Documentation Overview

The user documentation for the R&S SGT consists of the following parts:

® "Getting Started" printed manual

® Documentation CD-ROM with:
— Online help system (*.chm) as a standalone help

— User Manual for base unit and options
— Service manual

e —
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— Data sheet and product brochure
— Links to useful sites on the R&S internet

R&S SGMA-GUI Online Help

The Online Help is embedded in the R&S SGMA-GUI software. It offers quick,

context-sensitive access to the complete information needed for operation and
programming. The online help contains help on operating the R&S SGT and all
available options.

Getting Started

This manual is delivered with the instrument in printed form and in PDF format on
the Documentation CD-ROM. It provides the information needed to set up and
start working with the instrument. Basic operations and typical measurement
examples are described. The manual includes also general information, e.g.,
safety instructions.

User Manual

The User Manual is a supplement to the Getting Started manual. The manual is
available in PDF format - in printable form - on the Documentation CD-ROM deliv-
ered with the instrument. In this manual, all instrument functions are described in
detail. Furthermore, it provides an introduction to remote control and a complete
description of the remote control commands with programming examples. Infor-
mation on maintenance, instrument interfaces and error messages is also given.

Service Manual

The Service Manual is available in PDF format - in printable form - on the docu-
mentation CD-ROM delivered with the instrument. It informs on how to check
compliance with rated specifications, on instrument function, repair, troubleshoot-
ing and fault elimination. It contains all information required for repairing the
instrument by the replacement of modules.

Web Help

The content of the web helps correspond to the user manual for the latest product
version.

The web help is an additional file format that offers quick online access. This for-
mat is not intended for download but rather for accessing the required information
directly form the R&S website.

]
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Web helps are available at the R&S website, on the R&S SGT product page at
http://www2.rohde-schwarz.com/product/SGT100A.html > Download > Web Help.

1.3  Typographical Conventions

The following text markers are used throughout this documentation:

Convention Description

"Graphical user interface All names of graphical user interface elements on the screen,

elements” such as dialog boxes, menus, options, buttons, and softkeys are
enclosed by quotation marks.

KEYS Key names are written in capital letters.

File names, commands, |File names, commands, coding samples and screen output are

program code distinguished by their font.

Input Input to be entered by the user is displayed in italics.

Links Links that you can click are displayed in blue font.

"References" References to other parts of the documentation are enclosed by

quotation marks.
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Putting into Operation

2 Preparing for Use

o Putting into OPeration.............coeii i 8
o Linux Operating SYStem......ccouuiiiiiiiiic e 16
e Connecting an External PC and DevViCes..........ucceeiiiiiiiiiiiiccie e, 16

2.1 Putting into Operation

This section describes the basic steps to be taken when setting up the R&S SGT
for the first time.

Risk of injury and instrument damage

The instrument must be used in an appropriate manner to prevent electric
shock, fire, personal injury, or damage.

® Do not open the instrument casing.

® Read and observe the "Basic Safety Instructions" at the beginning of
this manual or on the documentation CD-ROM, in addition to the safety
instructions in the following sections. Notice that the data sheet may
specify additional operating conditions.

NOTICE

Risk of instrument damage

Note that the general safety instructions also contain information on operat-
ing conditions that will prevent damage to the instrument. The instrument's
data sheet may contain additional operating conditions.
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NOTICE

Risk of electrostatic discharge (ESD)

Electrostatic discharge (ESD) can cause damage to the electronic compo-

nents of the instrument and the device under test (DUT). ESD is most likely
to occur when you connect or disconnect a DUT or test fixture to the instru-
ment's test ports. To prevent ESD, use a wrist strap and cord and connect

yourself to the ground, or use a conductive floor mat and heel strap combi-
nation.

For details, refer to the safety instructions delivered in electronic format on
the documentation CD-ROM.

NOTICE

Risk of instrument damage during operation

An unsuitable operating site or test setup can cause damage to the instru-
ment and to connected devices. Ensure the following operating conditions
before you switch on the instrument:

® All fan openings are unobstructed and the airflow perforations are unim-
peded. The minimum distance from the wall is 10 cm.

® The instrument is dry and shows no sign of condensation.
® The instrument is positioned as described in the following sections.

® The ambient temperature does not exceed the range specified in the
data sheet.

® Signal levels at the input connectors are all within the specified ranges.
® Signal outputs are correctly connected and are not overloaded.

211 EMI Suppression

Electromagnetic interference (EMI) may affect the measurement results.

To suppress generated Electromagnetic Interference (EMI),

Use suitable shielded cables of high quality. For example use double-shielded
RF and LAN cables.

Note: USB cables are of varying and often poor quality. Therefore, check the
quality of each individual USB cable as described in the service manual.

]
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® Always terminate open cable ends.

® Use the cable R&S SMU-Z6 for connection to the DIG 1/Q interfaces of the
instrument. The required cable is available under part number 1415.0201.02.

® Note the EMC classification in the data sheet

2.1.2 Unpacking and Checking the Instrument

Check the equipment for completeness using the delivery note and the accessory
lists for the various items. Check the instrument for any damage. If there is dam-
age, immediately contact the carrier who delivered the instrument. Make sure not
to discard the box and packing material.

Packing material

Retain the original packing material. If the instrument needs to be transpor-
ted or shipped at a later date, you can use the material to protect the control
elements and connectors.
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NOTICE

Risk of damage during transportation and shipment

Insufficient protection against mechanical and electrostatic effects during
transportation and shipment can damage the instrument.

® Always make sure that sufficient mechanical and electrostatic protection
is provided.

® When shipping an instrument, the original packaging should be used. If
you do not have the original packaging, use sufficient padding to pre-
vent the instrument from moving around inside the box. Pack the instru-
ment in antistatic wrap to protect it from electrostatic charging.

® Secure the instrument to prevent any movement and other mechanical
effects during transportation.

The carrying handles at the front and side of the casing are designed to lift
or carry the instrument. Do not apply an excessive external force to the
handles.

Observe the information on transporting heavy instruments in the basic
safety instructions included at the front of the printed manual and on the
supplied CD ROM.

21.3 Accessory List

The instrument comes with the following accessories:

® Power cable
® (Getting Started printed manual
® R&S SGT User Documentation CD-Rom

21.4 Placing or Mounting the Instrument

The R&S SGT is designed for use under laboratory conditions, either on a bench
top or in a rack using a rack adapter kit (order number see data sheet).

Bench Top Operation

If the R&S SGT is operated on a bench top, the surface should be flat. The instru-
ment can be used in horizontal position, standing on its feet.

]
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A CAUTION

Risk of injury and instrument damage if stacking instruments

A stack of instruments may tilt over and cause injury. Furthermore, the
instruments at the bottom of the stack may be damaged due to the load
imposed by the instruments on top.

Observe the following instructions when stacking instruments:

® Never stack more than three instruments with the same dimensions
(width and length). If you need to stack more than three instruments,
install them in a rack.

® The overall load imposed on the lowest instrument must not exceed
500 N.

® Allinstruments should have the same dimensions (width and length).
If you need to stack smaller instruments on the top, the overall load
imposed on the lowest instrument must not exceed 250 N.

® |[f the instruments have foldable feet, fold them in completely.

—Y 0 ¢
o o | 7 | ]
— 2

L ™

() | ) ]

[ ) =) | [ =]

Ty N |y

Correct Too many instruments Different dimensions Feet folded out

Rackmounting

The R&S SGT can be installed in a rack using a rack adapter kit (Order No. see
data sheet). The installation instructions are part of the adapter Kkit.

-
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NOTICE

Risk of instrument damage in a rack

An insufficient airflow can cause the instrument to overheat, which may dis-
turb the operation and even cause damage.

Make sure that all fan openings are unobstructed, that the airflow perfora-
tions are unimpeded, and that the minimum distance from the wall is 10 cm.

21.5 Switching the Instrument On and Off

The R&S SGT is automatically adapted to the AC voltage supplied. There is no
need to set the voltage manually or change fuses. The AC SUPPLY AND
POWER SWITCH is at the rear of the unit.

To connect the AC supply

» Connect the R&S SGT to the AC power source using the AC power cable
delivered with the instrument.

Note: The instrument is in compliance with safety class EN61010-1.
Connect the instrument only to a socket with earthing contact.

To start up the instrument

1. Connect the instrument to the AC supply.

2. To turn the power on, press the main power switch to position | (On).

To switch between standby and ready state

» Press the POWER ON/STAND BY key briefly to switch the instrument from
the standby to ready state or vice versa.

-
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In ready state, the button is green. The instrument is ready for operation. All
modules are power-supplied and the R&S SGT initiates its startup procedure.
In standby state, the button is orange. The standby power only supplies the
power switch circuits and built-in oscillator to keep it at its operating tempera-
ture. The remote control system is not active.

Start-up and booting

The instrument boots the operating system and starts the instrument firmware.
During the booting process the green POWER ON/STAND BY key blinks. If the
previous session was terminated regularly, the instrument uses the last setup with
the relevant instrument settings.

Once the startup procedure has been terminated, the instrument is ready for
operation.

In the R&S SGMA-GUI, select "Instrument > Preset" function to return the
instrument to its defined reset/preset state, if the current setup is no longer
relevant.

To customize the start settings, use the "SGMA-GUI > File > Save As/Open"
function.

To shut down the Instrument

To shut down the R&S SGT, proceed as described below.

» To turn the power off, press the main power switch to position 0 (Off).

None of the front-panel LEDs should be on.

2.1.6 Function Check

The instrument automatically monitors the main functions when it is switched on
and monitors them continuously during operation.

A detected fault is indicated by an "Error" message displayed in the info line of
the R&S SGMA-GUI together with a brief error description. For an in-depth identi-
fication of the error, press the "SGMA-GUI > Info" button. In response, a descrip-

]
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tion of the error(s) is displayed. For more information, refer to the "Error Mes-
sages" section in the User Manual.

In addition to the automatic monitoring, the R&S SGT offers the following capabili-
ties to ensure correct functioning:

® |nternal Adjustments
In the R&S SGMA-GUI, select the "Instrument > Setup > Internal Adjust-
ments" dialog to access the dialog for performing and configuring the adjust-
ments settings. A maximum level accuracy can be obtained, for instance.

® Selftest
A selftest is provided for service purposes ("SGMA-GUI > Instrument > Diag-
nostic/Test > Self Test").

2.1.7 Default Settings

When the instrument is switched on, it is not the preset state that is active, but
rather the instrument state that was set before the instrument was switched off. It
is recommended that you use the "SGMA-GUI > Instrument > Preset" function to
return the instrument to its defined preset state every time a new configuration is
required or the current setup is no longer relevant.

The R&S SGT offers a two-stage preset concept:

® Preset the instrument to a predefined state
The "SGMA-GUI > Instrument Name > Preset" function calls up a defined
instrument setup. All parameters and switching states are preset (also those
of inactive operating modes). The default instrument settings provide a repro-
ducible initial basis for all other settings. However, functions that concern the
integration of the instrument into a measurement setup are not changed.

® Preset the instrument to its factory settings
The instrument can also be forced to load its default factory settings. To
access the corresponding dialog box, select the "SGMA-GUI > Instrument
Name > Setup > Factory Preset" function.
For more information and an overview of the settings affected by the factory
preset function, see the "Factory Preset" section in the User Manual.

User-defined instrument states can be stored and called up using the func-
tions "SGMA-GUI > File > Save As/Open".

-
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2.2 Linux Operating System

The instrument uses an embedded Linux operating system, optimally adapted to
the instrument.

Accessing the Operating System
No access to the operating system is required for normal operation.
All necessary system settings can be made in the "Setup" dialog.

2.3 Connecting an External PC and Devices

As arule, the R&S SGT is operated exclusively via remote control on a connec-
ted PC. Another way to control the instrument is the manual operation via the
R&S SGMA-GUI software on the connected PC.

Both the remote control and the manual operation of the instrument require an
external controller. For the prerequisites and the instructions on how to configure
an external controller for remote control, refer to the User Manual. A brief intro-
duction to the remote control capabilities is provided in chapter 5.2, "Network and
Remote Control Operation", on page 41.

This section gives an introduction on how to configure the external PC for manual
operation (see chapter 2.3.1, "Installing the R&S SGMA-GUI Software on an
External PC", on page 17).

In addition to connecting an external controller, it may be useful to connect other
external devices, e.g. a memory stick. The following interfaces are provided on
the rear panel of the instrument, see also chapter 3.2, "Rear Panel Tour",

on page 25:

® PCI Express (refer to chapter 2.3.3, "Connecting a Controller via PCI
Express", on page 20

® USB interface (refer to chapter 2.3.4, "Connecting a Controller or an USB
Device via USB", on page 21)

® | AN interface (refer to chapter 2.3.2, "Connecting a Remote PC via LAN",
on page 18)
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2.3.1 Installing the R&S SGMA-GUI Software on an External PC

The R&S SGMA-GUI is delivered in the latest version available on the CD-ROM
included in the instrument's delivery. Software updates as well as the Release
Notes describing the improvements and modifications are provided on the Inter-
net at the download site of the Rohde&Schwarz home page. This home page
always offers the latest information on your R&S SGMA-GUI.

The R&S SGMA-GUI software is provided as separate installation package
for the different operating systems.

This description focuses on the handling of the Windows-32 version. The
file naming conventions and the installation instructions for the other operat-
ing systems are analogous.

The R&S SGMA-GUI installation package for Windows-32 operating system con-
sists of the file SGMA-GUI <V.VV.VVV.VVV>.exe. The version numbers in the
file names vary with each update. To install the R&S SGMA-GUI, the following
hardware and software requirements have to be met.

Table 2-1: Hardware and Software Requirements

Requirement Remark

One of the following operating | R&S SGMA-GUI has to be installed on one of the supported
operating systems.

systems:
® Windows XP SP2 Note:
i
e  Windows Vista ﬁnty other r\{Vicr;dows version or other operating systems are
e Windows 7 Ot stpported. _ o
e \Windows 8/ 8.1 Wlndows Installer Version 4.5 or hlgher is needed for the
e Linux installation of the software on a Windows XP computer.

During installation, the operation system is checked.
The installation will be terminated if this requirement is not ful-
filled.

National Instruments (NI) VISA | VISA drivers can be obtained from R&S or NI directly.
version 3.4.1 or higher
(optional)

or

Agilent VISA version 14 or
higher (optional)

CPU At least Pentium or compatible, as from 1 GHz (recommen-
ded).

VGA color display resolution At least 800*600 pixels

-
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Installing a new software version

6 Administrator rights are necessary for installation and starting.

» In Windows Explorer double-click SGMA-GUI V.VV.VVV.VVV.exe and fol-
low the instructions.
Uninstalling an old software version

An uninstallation of a previous version of the SW can be performed prior to the
installation of the new one but is not mandatory.

» To uninstall this version, go to "Start > Settings > Control Panel > Add/
Remove Programs" and select the entry SGMA-GUI V.VV.VVV.VVV.

The script file identifies and removes all currently installed R&S SGMA-GUI
software items.

2.3.2 Connecting a Remote PC via LAN

The R&S SGT is equipped with a network interface and can be connected to an
Ethernet LAN (local area network). The interface can be used, for example:

® To connect an external computer for manual control of the instrument by
means of the R&S SGMA-GUI software.

® To operate the device by a remote control program.
See chapter 5.2, "Network and Remote Control Operation", on page 41.

This section describes how to configure the LAN interface. It includes the follow-
ing topics:

® chapter 2.3.2.1, "Connecting the Instrument to the Network", on page 18
® chapter 2.3.2.2, "Assigning the IP Address", on page 19

® chapter 2.3.2.3, "Automatically adding instruments to the SGMA-GUI ",
on page 20

2.3.21 Connecting the Instrument to the Network

There are two methods to establish a LAN connection to the instrument:
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® A non-dedicated network (Ethernet) connection from the instrument to an
existing network.

® A dedicated network connection (Point-to-point connection) between the
instrument and a single computer.

In both cases, an IP address has to be assigned to the instrument and the com-
puter, see chapter 2.3.2.2, "Assigning the |P Address", on page 19.

Setting Up a Network (LAN) Connection

Risk of network failure

Before connecting the instrument to the network or configuring the network,
consult your network administrator. Errors may affect the entire network.

» Connect the instrument to the network or to a single PC.

If the instrument is connected to the LAN, the operating system automatically
detects the network connection and activates the required drivers.

By default, the instrument is configured to use dynamic TCP/IP configuration
and obtain all address information automatically.

2.3.2.2 Assigning the IP Address

Depending on the network capacities, the TCP/IP address information for the
instrument can be obtained in different ways.

® |f the network supports dynamic TCP/IP configuration using the Dynamic Host
Configuration Protocol (DHCP), all address information can be assigned auto-
matically.

® |f the network does not support DHCP, the instrument tries to obtain the IP
address via Zeroconf (APIPA) protocol. If this attempt does not succeed or if
the instrument is set to use alternate TCP/IP configuration, the addresses
must be set manually.

The R&S SGT uses the Zeroconf IP addresses 169.254 .xxx.yyy., where xxx
may take values between 1...254 and yyy the values in the value range
1...255; the subnet mask is always 255.255.0.0. The IP address of the host
must be within the same address area for Zeroconf.

-
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By default, the instrument is configured to use dynamic TCP/IP configuration and
obtain all address information automatically. This means that it is safe to establish
a physical connection to the LAN without any previous instrument configuration.

2.3.2.3 Automatically adding instruments to the SGMA-GUI

For information on how to install the R&S SGMA-GUI software, refer to
chapter 2.3.1, "Installing the R&S SGMA-GUI Software on an External PC",
on page 17.

1. For each new instrument perform the following steps:

a) Connect the instrument to the network.

b) Press the POWER ON/STAND BY key to switch on the instrument.
c) Wait until the POWER ON/STAND BY LED is green and not blinking.
d) Press the ID key on the front panel of the instrument.

2. Start the SGMA-GUI on a computer connected to the same network.

3. Open the "Instruments" dialog and click "Scan".

Note: This step is performed automatically on the first start and can also be
omitted for instruments with a direct LAN connection to the computer.

All instruments will be added automatically to the main panel of the SIGMA-
GUI.

2.3.3 Connecting a Controller via PCI Express

A PCI Express connector is provided on the rear panel of the instrument, see
chapter 3.2, "Rear Panel Tour", on page 25.

NOTICE

Risk of device failure

The R&S SGT is equipped with a single lane PCle interface that supports
hot plugging.

Do not connect an external PC to the PCle connector of the instrument dur-
ing operation if this external PC does not support hot-plugging!
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Using the PCle interface for remote control of the instrument requires extended
knowledge and is described in section "Advanced Remote Control via PCle" in
the User Manual.

2.3.4 Connecting a Controller or an USB Device via USB

The USB interface on the rear panel of the R&S SGT allows you to connect either
an USB device or use the R&S SGT as a device and connect it to a controller.
Connecting a controller (host PC or compatible signal generator)

If you connect a controller (host PC or compatible signal generator) to the
R&S SGT, the R&S SGT acts as an USB device.

To connect the controller to the USB interface of the R&S SGT, always connect
the USB Type Micro-B connector to the R&S SGT. Refer to the documentation
of the controller to find out which USB connector type you can connect to the con-
troller.

The figure 2-1 illustrates schematically the required connector type to emphasize
on the different connector shape.

NETY

Fig. 2-1: USB Type Micro-B connectors

An external PC with installed R&S SGMA-GUI is required for manual operation of
the R&S SGT.

On the remote PC, perform the steps as described in chapter 2.3.2.3, "Automati-
cally adding instruments to the SGMA-GUI ", on page 20.
Connecting an USB device

If you connect an USB device (Memory stick, CD-ROM, an instrument) to the
R&S SGT, the R&S SGT acts as a host.

To connect an USB device to the interface of the R&S SGT, always connect the
USB Type Micro-A connector to the R&S SGT. Refer to the documentation of
the USB device to find out which USB connector type you can connect to the
USB device.

]
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The figure 2-2 illustrates schematically the required connector type to emphasize
on the different connector shape.

[T ]

Fig. 2-2: USB Type Micro-A connectors
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3 Instrument Tour

The following topics will help you get familiar with the instrument and perform the
first steps:

® Front Panel Tour
® Rear Panel Tour

This section explains the control elements and the connectors of the R&S SGT
with the aid of the front and rear views. Specifications of interfaces can be found
in the data sheet.

3.1 Front Panel Tour

This section provides an overview of control elements on the front panel of the
R&S SGT. The connectors of the R&S SGT are placed on the rear panel and are
described in chapter 3.2, "Rear Panel Tour", on page 25. As the R&S SGT is
mainly intended to be remote-controlled, the front panel of the R&S SGT contains
no display but mostly LEDs to inform the user about the status of the instrument.
The user interface can be displayed on a remote PC station used to manually
remote control the instrument.

/ @ ROHDE&SCHWARZ SGMA - VECTOR RF SDUHCR

R&S SGT100A 3 6 GHz IQ

| ERROR /
[0) RFON  REFEXT iolile

@» @ @ T

Fig. 3-1: Front panel view

POWER ON/STAND BY

The POWER ON/STAND BY key switches the instrument from the standby to
ready state or vice versa.

In ready state, the button is green. The instrument is ready for operation.

-
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In standby state, the button is orange. In this state it is safe to switch off the AC
power and disconnect the instrument from the power supply.

A blinking green color indicates that a booting operation is in proccess.

RF ON

The RF ON key switches the RF signal on or off. If activated, the button is green.

REF EXT

O

The REF EXT LED indicates the status of the external reference.

® Green indicates that the instrument can synchronize to the external clock.
® Red indicates that the instrument cannot synchronize to the external clock.
® No light indicates that the internal reference is used.

RROR / WARNING

=

The ERROR / WARNING LED indicates the status of the R&S SGT.

® Red indicates that an error has occurred, e.g. temperature exceeded or power
failure.

® Blinking orange indicates a running process (e.g calibration, self test).

® No light indicates that no errors or warnings have occurred.

For details on errors or warnings refer to the graphical user interface on a remote
PC ("SGMA-GUI > Info").

For more information, refer to the "Error Messages" section in the User Manual.

LAN

Pressing the key for more than 3 s resets the LAN interface settings, i.e the "IP
Adress Mode" is reset to DHCP.

-
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ID

=

Pressing the ID key while the instrument is active,opens the "SGMA-GUI > Setup
> Instruments > Configure Instruments > Edit Instrument" dialog of the corre-
sponding instrument on the remote controller.

Pressing the ID key of an inactive instrument and starting "SGMA-GUI > Setup >
Instruments > Scan", leads to an automatic activation of the instrument in the
SGMA-GUI.

3.2 Rear Panel Tour

This section provides an overview of the connectors on the rear panel of the
instrument. For technical data of the connectors refer to the data sheet.

Fig. 3-2: Rear panel view

NOTICE

Protection of mechanical components

To avoid damage of the SMA connectors it is essential to limit the tightening
torque to 60 Ncm. Use an adequate 8 mm torque wrench and not an ordi-
nary open-end wrench.

PCI EXPRESS CONNECTOR
| F—Jdrce Ly J

-
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The PCle (Peripheral Component Interconnect Express) single lane interface
allows remote control with optimized speed.

For details see chapter 2.3.3, "Connecting a Controller via PCI Express”,
on page 20.

USB CONNECTOR

The USB (universal serial bus) interface, Type Micro, allows you to connect vari-

ous external devices, e.g.:

® |[f the interface is configured as a device interface, a remote computer can be
connected for firmware update, manual operation via the R&S SGMA-GUI
software or for remote control of the instrument.

For details see chapter 2.3.4, "Connecting a Controller or an USB Device via
USB", on page 21.

LAN CONNECTOR
[ Jon] |

-
The LAN (Ethernet) interface allows you to connect the R&S SGT to other devi-
ces, e.g. a remote computer, for firmware update, manual operation via the R&S

SGMA-GUI software or for remote control of the instrument. The connection to
the remote computer can be direct or via a network.

For details see chapter 2.3.2, "Connecting a Remote PC via LAN", on page 18.

DIGITAL 1I/Q

Input of a digital 1/Q signal.

-
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O

Multi purpose connectors. The input/output signal has to be defined, e.g. "Trig-
ger", "Marker 1/2", "Clock In/Out", "Sync In/Out".

USER 1 is an SMB connector while USER 2 is an SMA female connector.

Connector USER 2 can be additionally used as an input for external pulse modu-
lator sources.

RF50C2

D &

Provides an RF 50 Ohm signal output.

NOTICE! Maximum Input Levels. Do not overload the RF output. The maximum
permissible back-feed is specified in the data sheet.

I,Q
©-°@

Inputs of the 1/Q modulator, provided for feeding of external signal.

NOTICE! Maximum Input Levels. Do not overload the | and Q inputs. The maxi-
mum permissible voltage is 1V. For details, refer to the data sheet.

]
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I, Q OUT

The | OUT/I BAR OUT and Q OUT/Q BAR OUT connectors are for direct output
of the analog 1/Q signal.

Connectors for reference or local oscillator signals, and alternatively also in MIMO
setups.

Reference input and output:
® REF IN: Input for external reference signal.
® REF OUT: Output of internal reference signal.

Local oscillator input and output:
® | O IN: Input for external LO signals
® | O OUT: Output of internal LO signals.

AC SUPPLY AND POWER SWITCH

The AC supply and power switch allow you to connect the R&S SGT to the power
supply and switch on the instrument.

For details see "To connect the AC supply" on page 13.

]
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This chapter introduces the most important functions and settings of the
R&S SGT step by step.

The complete description of the functionality and its usage is given in the
R&S SGT User Manual.
Prerequisites

As a prerequisite for this examples, the R&S SGT has to be connected to a
remote PC. The R&S SGMA-GUI software has to be installed on this remote PC
and the instrument is added to the list of "Available Instruments".

For information on how to fulfill these requirements, refer to:
® chapter 2.3.2.1, "Connecting the Instrument to the Network", on page 18

® chapter 2.3.1, "Installing the R&S SGMA-GUI Software on an External
PC", on page 17

® chapter 2.3.2.3, "Automatically adding instruments to the SGMA-GUI ",

on page 20
o How to Generate @ CW Signal.......ccouueeiiiiiieiieccee e 30
e How to Create a Waveform File with R&S WinlQSIM2 and Load it in the ARB
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4.1 How to Generate a CW Signal

Configuring the R&S SGT to generate a CW signal

| AN | & RONDEASCHWARZ S5Wh - VCTON N Simmcy
T
‘ REF/LO QU
© -I e 9;5 g
= s — = - 8 9
3 g 3 3
4+ R&SSGMA- | © e ¢ s
T g REF IN
I} <—J
= RF IN
= |

Fig. 4-1: Example of the setup

1. Check the front panel of the R&S SGT.
The POWER ON/STAND BY key has to be green.

2. On the connected remote PC, start the R&S SGMA-GUI software application.

The main panel of the application opens. The panel provides a quick access
to the main settings of the configured and activated instruments. The display
shows one row per instrument with the instrument specific settings. The rows
comprise the instrument, the connection state, the used frequency and power
level, the state of the RF output and the modulator and the used reference fre-
guency source.

0 SGMA-GUT =R =R 5
File Setup Help
e
[ ].O Info.|
| ' .| RE Mod ' Ext [ |
o: | SGT |qu[ 2.000 000 000 000]c#= -| BE Mod PEPdBm Lovel _-30.00- REE

3. In the R&S SGMA-GUI main panel, the green indicator in front of the instru-
ment's name confirms that there is a connection between the instrument and
the remote PC and that the instrument is recognized by the software.

4. Inthe R&S SGMA-GUI main panel, select the row corresponding to the instru-
ment to be configured and select "Instrument Name > Preset" to restore the
predefined instrument's settings.

]
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70 SGMA-GUI =N EoR (=
File Setup Help

CICCES
[ ].6 Info.|

GHz v‘ 51'; %‘g? PEP| -30.00{dBm Level :-30_00|dBm ‘ E% @ J

®[E  SeT  Fea| 2.000000 000 000

Baseband 4
BB Input 4
AWGN...
Impairments...

1/Q Mod....

Analog Outputs....
RF 4
Connectors....

Standby

Restart

Setup 4
Diagnostic / Test ¥

Service 4

5. In the R&S SGMA-GUI main panel, select the row corresponding to the instru-
ment to be configured and adjust the "Frequency" as required.

6. Select "SGMA-GUI > RF On" to enable the output of the CW signal.

¥ SGMA-GUI =N B =< 1
File Setup Help
R ==
[ ].8 Info.|
LIE | SGT | Freq| 2.000 000 000 000|GHz v‘ %‘g? PEPdBm Level -30.00|dBm ‘ Eo% w
ARB: None
Baseband [ awen |  impairments | [ vamod | RF o
(Jon [Jon [Jon [(Jon — _G"
ARB AWGN NP
e e BB Input 11Q Analog _”5(1511
W —( [ o o | 5
mput it User 1: Marker 1

User 2: Marker 2

The 2 GHz signal is output at the RF OUT connector at the rear panel of the
R&S SGT.

-
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4.2 How to Create a Waveform File with R&S WinlQ-
SIM2 and Load it in the ARB

The following is an example on how to use the R&S WinlQSIM2 to generate a
waveform and load it in the ARB of the R&S SGT.

The workflow consists of three main steps, each described in a separate step-by-
step instruction:

® Configuring the connection between the R&S WinlQSIM2 and the R&S SGT.
® (Generating a waveform file with the required settings.

® Transferring the waveform file and playing it with the R&S SGT.

This section does not describe the R&S WinlQSIM2 but focuses only the
task related settings.

For more information on configuration and working with the R&S WinIQ-
SIM2, refer to description "Software Manual R&S WinlQSIM2".

To configure the R&S SGT as destination instrument in the R&S WinlQSIM2

In this example, we assume that the R&S WinlQSIM2 is installed on a remote
controller. This remote controller is connected over LAN to the R&S SGT.

The general instrument settings of the destination instrument affect various func-
tions, like, the maximum size of the file the waveform is stored in. It is recommen-
ded that you configure the destination instrument before you generate the wave-
form with the R&S WinlQSIM2.

1. In the R&S WinlQSIM2, select "File > New" to preset the software to a defined
state.

2. In the block diagram, select "Vector Sig Gen > Config > Instruments".

—_—

Remote Desktop

Remoate Control (SCPI)
O |

The "Configure Instruments" dialog opens. The list of configured instruments
is empty.

3. Select "Configure Instruments > Scan".

-
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4}’ WinIQSIM2: Configure Instruments
Available Instruments
Symbolic Name Instrument Type =
1[8GT10007 SGT

The software scans the network for connected and active instruments.
Alternatively, use the "New" function to add the R&S SGT manually to the list
of instruments.

4. Close the dialog.

5. In the block diagram, select "Vector Sig Gen" block and select the R&S SGT
form the list.

6. Inthe block diagram, select "Arb Sig Gen" block and select the R&S SGT form
the list.
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4 Rohde&Schwarz WinIQSIM2 (=]
File Transmission Graphics Help
B = e P FEE
samples | 0|samp ~| sample Rate | ojHz x|
| Info |

Waveform
Baseband
config...

[~ On .

MSK ‘
AWGN

config...
[~ On

Arb Sig Gen
config...
SGT10007 -

LAN
Remote Control

|
Vector Sig Gen

config...
SGT10007 M
LAN
Remote Control

The two lines to the "Vector Sig Gen" and "Arb Sig Gen" blocks on the block
diagram confirm that a remote connection to the R&S SGT is established.

To generate a LTE example waveform file with the R&S WinlQSIM2

1. Inthe R&S WinlQSIM2, select "Block diagram > Baseband > Config. >
EUTRA/LTE".

2. Adjust the settings as required, for example:
a) select "Link Direction > Downlink"

b) select a predefined test model, "Test Setups/Models > E-TM1_1__ 10MHZz"

3. Enable "EUTRAJ/LTE > State > On".
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=15 x|

State

Set To Default | Savel/Recall... |

Data List Management... | Generate Waveform File... |

3GPP Version Release 10

Duplexing |FDD =

Link Direction | Downlink (OFDMA) M

Sequence Length | 1|Frames = |

Test Setups/Models... | E-TM1_1__10MHz
General DL Settings... |
Frame Configuration... |

Filter/Clipping/Power... | LTE I Clip Off
Marker... |

The R&S WinlQSIM2 calculates the signal and displays important signal
parameters, like the used "Sample Rate" and "Number of Samples".
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@ Use "Graphics > Graphic 1 (Complete)" view to retrieve more information

on the generated signal.

}Tolal Signal Duration: 307200 Samples (= 10 ms)

Generated Waveform File
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Sample Rate (fc): 30.72 MHz

Viewport
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100 000 Unit |Samples |

[l
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Cursor 1 Delta: 1 -2 Units:
e | 0.00 || 295 ||| .95 || [mez |
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The display confirms the expected EUTRA/LTE 10 MHz spectrum.

To transfer the generated file to the R&S SGT
1. In the R&S WinlQSIM2, select "Transmission > Transmit".

2. In the "Waveform Transmission to Arbitrary Waveform Generator" dialog,

select:
a) "Source > Internal (WinlQSIM2)"

b) "Destination > Instrument" and define the file name the transmitted file will

be stored as.

c) Enable "Automatically Load and Start Waveform > On" and select the

required baseband, e.g. "Path A"
d) Add a comment to the waveform.
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e) Select "Transmit".

4}* WinIQ5IM2: Waveform Transmission To Arbitrary Waveform Generator “SGT10007™ - | I:Ilil
User Comment for FilenWaveform

I LTE_TM_1_10_WinlQSIM2_WV I

Source
[nternal (Winiasim2) ~ | EUtraKernelLog1_Filtered.wv
Destination
IFiIe j File... | userwy
Transmit Waveform
Transmit |

The waveform is transmitted to the default directory of the R&S SGT.
3. Inthe R&S SGT, select "Baseband > ARB".

The dialog confirms that the ARB is enabled and plays the transmitted wave-
form.



R&S®SGT100A Instrument Control

5 Instrument Control

As a rule, the R&S SGT is operated exclusively via programmatic remote control
from a connected PC. For service and diagnostic tasks, as well as for manual
configuration, a graphical user interface (R&S SGMA-GUI) is provided which runs
on the remote PC.

Additionally, some basic functionality is provided via the keys on the front panel of
the instrument (see chapter 3.1, "Front Panel Tour", on page 23).

5.1 Manual Operation via R&S SGMA-GUI

The R&S SGMA-GUI software application can be installed on a PC with Windows
or Linux operating system. This program allows you to control several devices of
the SGMA product family at the same time and to monitor the device status dur-
ing remote control. R&S SGMA-GUI requires one of the external interfaces
described in chapter 2.3, "Connecting an External PC and Devices", on page 16.

511 Introduction to the User Interface

After the start of R&S SGMA-GUI the main dialog of the application is displayed.

A SGMA-GUT oy [=] B3]

File Setup Help

8= m=
| nfo|

o SGT |E|Freq| 1.000 000 000 000G ~| e 8] moa [BH] pep[ -10.00 dBm Lovei] 10.00fawm ] wer mi|

ARB: None

Baseband AWGN Impairments
— RF
ot || ] oo (|| e [ o | e | 5
I~ On [~ On [~ On — v v
ARB AWGH IMp
Jr
BB Input BB Qutput
DIG V2 IN
T config... | config... |

[~ on [ on
Input Output

User 1: Marker 1
User 2: Marker 2

The main dialog with an overview of the configured instruments is the operating
and control interface for the whole program. From here, all program functions are
accessible.
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The menus and dialogs are built using elements like selection lists, check boxes,
and entry fields. A blue frame indicates that the selected item is active. Entries
can be made in the highlighted element.

The main dialog comprises two main areas:

® On the top of the main panel, there are the menu bar, the tool bar and the info
bar with the corresponding "Info" button.
The menu bar provides access to the functions related to the software appli-
cation itself, like saving current configurations, resetting the display, retrieving
information about the installed software version or configuring the connected
instruments.
The messages displayed in the info line indicate information, warnings, and
errors. They are displayed in different colors depending on their importance
and display duration. Use the "Info" button to open a dialog with information
on the messages in greater detail.

® The central part of the R&S SGMA-GUI main dialog is the main panel that
shows the list of all active instruments.
The main panel is the core element for the manual operation and provides
quick access to the main settings of the configured instruments. The display
shows one row per active instrument. Each row comprises the instrument's
name and state, the used frequency and level, the state of the RF output and
the modulator and the kind of used frequency reference.
The buttons with the instrument's symbolic name on it provides access to
menus and dialogs for further instrument configuration. Refer to the User
Manual for a detailed description of all parameters and functions provided for
configuration.

A detailed description of the R&S SGMA-GUI, in depth information on how
to work with the application and on how to operate the R&S SGT and per-
form general configuration tasks is provided in the User Manual.

5.1.2 How to Use the Help System
The R&S SGMA-GUI is equipped with a context-sensitive help function. A help

page is available for each parameter and can be called any time during instru-
ment operation.
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Compiled online help systems are also available on the CD-ROM supplied
with the instrument. This help program can be called on any controller with
Internet Explorer version V4.0 and higher.

Calling context-sensitive and general help

» To display the general help dialog box, select the "SGMA-GUI > Help > Con-
tents" or use the F1 key.

The help dialog is displayed. A topic containing information about the current
menu or the currently opened dialog box and its function is displayed.
Contents of the help dialog box

The help dialog box contains two main areas:
® "Contents" - contains a table of help contents
® "Topic" - contains a specific help topic

The help system additionally provides an "Index" and a "Find" area, as well as
"Zoom" functions that are accessed by means of the corresponding buttons.
Navigating in the table of contents and in the help topics

1. To move through the displayed contents entries, use the mouse or the UP/
DOWN keys. Entries that contain further entries are marked with a plus sign.

2. To display a help topic, double click on the topic name or press the ENTER
key.

3. To jump to the linked topic, press the link text.

4. Use the "Previous" or "Next" links to jump to the corresponding topic.

5. Use the "Scroll Right" or "Scroll Left" buttons to shift the indicated area of the
navigation window to the left or right.

Using the Index

1. Select "SGMA-GUI > Help > Index" or use the "Go to Index" button in the
"Help" display.

2. Enter the first characters of the topic you are interested in. The entries starting
with these characters are displayed.

]
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3. Press the ENTER key to display the help topic.
The corresponding help topic is displayed.

5.2 Network and Remote Control Operation

As an alternative to operating the R&S SGT interactively via the R&S SGMA-GUI,
one can also controll the R&S SGT using programmed commands from a remote
PC.

The description in this section requires basic knowledge of the remote con-
trol operation. Definitions specified in the SCPI standard are not provided.

Nevertheless, you will find some basic information to the SCPI syntax, com-
mand lists, and general programming recommendations in section Remote
Control Basics of the User Manual. In addition, this chapter provides infor-
mation on the status reporting system of the instrument.

5.21 Remote Control Interfaces and Protocols

The instrument supports several interfaces for remote control. The following table
gives an overview.

Table 5-1: Remote control interfaces and protocols

Interface | Protocols Remarks

Local ® HiSLIP High-Speed LAN Instrument Proto- | A LAN connector is located on the

Area Net- col (IVI-6.1) rear panel of the instrument.

work e VXI-11 The interface is based on TCP/IP

(LAN) ® socket communication (Raw Ethernet, and supports various protocols.
simple Telnet, Fast Socket) For details see chapter 5.2.1.1,

"LAN Interface", on page 42
USB USBTMC A USB connector is located on the

rear panel of the instrument.

For details see chapter 5.2.1.2,
"USB Interface", on page 45

PCle Proprietary A PCle connector is located on
the rear panel of the instrument.

For details see chapter 5.2.1.3,
"PCI Express Interface",
on page 46
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SCPI (Standard Commands for Programmable Instruments)

SCPI commands are used for remote control. Commands that are not taken from
the SCPI standard follow the SCPI syntax rules. The instrument supports the
SCPI version 1999. The SCPI standard is based on standard IEEE 488.2 and
aims at the standardization of device-specific commands, error handling and the
status registers. The tutorial "Automatic Measurement Control - A tutorial on SCPI
and IEEE 488.2" from John M. Pieper (R&S order number 0002.3536.00) offers
detailed information on concepts and definitions of SCPI.

5.2.1.1 LAN Interface

To be integrated in a LAN, the instrument is equipped with a LAN interface, con-
sisting of a connector, a network interface card and protocols.

For remote control via a network, the PC and the instrument must be connected
via the LAN interface to a common network with TCP/IP network protocol. They
are connected using an RJ45 cable (shielded or unshielded twisted pair category
5). The TCP/IP network protocol and the associated network services are precon-
figured on the instrument. Software for instrument control and (for specified proto-
cols only) the VISA program library must be installed on the controller.

(D) ldentifying instruments in a network

/ |If several instruments are connected to the network, each instrument has its
own |IP address and associated resource string. The controller identifies
these instruments by means of the resource string.

VISA Resource Strings

The VISA resource string is required to establish a communication session
between the controller and the instrument in a LAN. The resource string is a
unique identifier, composed of the specific IP address of the instrument and some
network and VISA specific keywords.

TCPIP::host address|[::LAN device name] [::INSTR]

® TCPIP designates the network protocol used

® host address is the IP address or host name of the device

® [::LAN device name] defines the protocol and the instance number of a sub-
instrument:

]
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|
® [::INSTR] indicates the instrument resource class (optional)

The IP address (host address/computer name) is used by the programs to iden-
tify and control the instrument. It is automatically assigned by the DHCP server
the first time the device is registered on the network. Alternatively, you can also
assign its LAN device name.

You can find the IP address in the "SGMA-GUI > Instrument Name > Setup >
Remote" dialog, and also adjust it manually, if required.

See below the characteristics of the VISA resource strings for the corresponding
interface protocols. The highlighted characters are crucial.
HiSLIP

TCPIP::host address::hislipO[::INSTR]

® hislip0 HiSLIP device name, designates that the interface protocol HiSLIP is
used (mandatory)

hislip0 is composed of [::HiSLIP device name[,HiSLIP port]] and must be
assigned.

For details of the HiSLIP protocol, refer to "HISLIP Protocol" on page 44.

VXI-11

TCPIP::host address[::inst0] [::INSTR]

® [::inst0] LAN device name, indicates that the VXI-11 protocol is used
(optional)

inst0 currently selects the VXI-11 protocol by default and can be omitted.

For details of the VXI-11 protocol, refer to ."VXI-11 Protocol" on page 45

Socket Communication

TCPIP::host address::port::SOCKET
® port determines the used port number
® SOCKET indicates the raw network socket resource class

Socket communication requires the specification of the port (commonly referred
to as port number) and of "SOCKET" to complete the VISA resource string with
the associated protocol used.

The registered port for socket communication is port 5025.

-
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See also "Socket Communication" on page 45.

Example:

® [nstrument has the IP address 70.7113.11.917; the valid resource string using
VXI-11 protocol is:
TCPIP::10.113.11.91::INSTR

® The DNS host name name is rssgt100a100021; the valid resource string is:
TCPIP::rssgtl100al100021::hislip0 (HiSLIP)
TCPIP::rssgtl100a100021::inst0 (VXI-11)

® A raw socket connection can be established using:
TCPIP::10.113.11.91::5025::SOCKET

HiSLIP Protocol

The HiSLIP (High Speed LAN Instrument Protocol) is the successor protocol for
VXI-11 for TCP-based instruments specified by the IVI foundation. The protocol
uses two TCP sockets for a single connection - one for fast data transfer, the
other for non-sequential control commands (e.g. Device Clear or SRQ).

HiSLIP has the following characteristics:

® High performance as with raw socket network connections

® Compatible IEEE 488.2 support for Message Exchange Protocol, Device
Clear, Serial Poll, Remote/Local, Trigger, and Service Request

® Uses a single IANA registered port (4880), which simplifies the configuration
of firewalls

® Supports simultaneous access of multiple users by providing versatile locking
mechanisms

® Usable for IPv6 or IPv4 networks

Note that HiSLIP data is sent to the device using the "fire and forget"
method with immediate return, as opposed to VXI-11, where each operation
is blocked until a VXI-11 device handshake returns. Thus, a successful
return of a VISA operation such as viWwrite () does not guarantee that the
instrument has finished or started the requested command, but is delivered
to the TCP/IP buffers.

For more information see also the application note: TMA208: Fast Remote Instru-
ment Control with HiSLIP.

]
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VXI-11 Protocol

The VXI-11 standard is based on the ONC RPC (Open Network Computing
Remote Procedure Call) protocol which in turn relies on TCP/IP as the network/
transport layer. The TCP/IP network protocol and the associated network services
are preconfigured. TCP/IP ensures connection-oriented communication, where
the order of the exchanged messages is adhered to and interrupted links are
identified. With this protocol, messages cannot be lost.

Socket Communication

An alternative way for remote control of the software is to establish a simple net-
work communication using sockets. The socket communication, also referred to
as “Raw Ethernet communication”, does not necessary require a VISA installation
on the remote controller side.

The simplest way to establish socket communication is to use the built-in telnet
program. The telnet program is part of every operating system and supports com-
munication with the software on a command-by-command basis.

Socket connections are established on a specially defined port. The socket
address is a combination of the IP address or the host name of the instrument
and the number of the port configured for remote-control. All instruments use port
number 5025 for this purpose. The port is configured for communication on a
command-to-command basis and for remote control from a program running on a
connected PC.

5.21.2 USB Interface

For remote control via USB connection, the PC and the instrument must be con-
nected via the USB interface. A USB connection requires the VISA library to be
installed. VISA detects and configures the R&S instrument automatically when
the USB connection is established. You do not have to install a separate driver.

You can retreive the USB resource string from the "SGMA-GUI > Instrument
Name > Setup > Remote" dialog.

-
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Example:

USB::0x0AAD: :0x00EC::100021::INSTR
O0x0AAD is the vendor ID for Rohde&Schwarz

O0x00EC is the product ID for the R&S SGT

100021 is the serial number of the particular instrument

5.2.1.3 PCI Express Interface

A PCI Express (PCle) connector is provided on the rear panel of the instrument.

Refer to chapter "Advanced Remote Control via PCle" of the User Manual the for
a description of how to set up a remote control connection via PCle and the per-
mitted cables.

Via PCI Express some commands can be sent to the instrument with optimized
speed (memory-mapped remote control), e.g. frequency or level settings. This
allows minimum setup time.

You can retreive the PCle resource string from the "SGMA-GUI > Instrument
Name > Setup > Remote" dialog.

Example:
PCIe::0x162f::0x1336::100021::INSTR
0x162f is the vendor ID for Rohde&Schwarz

0x1336 is the product ID for the R&S SGT

100021 is the serial number of the particular instrument

Using the PCle interface for remote control of the instrument requires
extended knowledge and is described in section "Advanced Remote Con-
trol via PCle" in the User Manual.

5.2.2 Example: Remote Control over LAN using the VXI-11 Pro-
tocol

In the following example, the program "Measurement & Automation Explorer"
from National Instruments is used on a Windows operating system to set up a
LAN remote control link and to start a remote control session. The remote control
program "Measurement & Automation Explorer" opens the connection to the

-
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instrument (using VISA functionality) and then sends commands to and receives
device responses from the instrument.

A remote control connection requires a VISA installation but no additional hard-
ware on the controller PC. The LAN I/O channel is selected at initialization time
using the VISA resource string (also referred to as "address string"). A VISA alias
(short name) is generally used to replace the complete resource string. The host
address is either the R&S SGT's computer name or its IP address.

Proceed as described in chapter 2.3.2.2, "Assigning the IP Address", on page 19
to determine the relevant address information.

In this example, it is assumed that:

® a LAN remote control link between the controller and the R&S SGT is
already set up.
For information on setting up the link see chapter 2.3.2, "Connecting a
Remote PC via LAN", on page 18.

® a VISA and the "Measurement & Automation Explorer" program are
installed on the remote PC.
For detailed information, refer to section "Remote Control Basics" in the
User Manual or to the online help of the "Measurement & Automation
Explorer" program.

To configure the controller

The instrument is preconfigured for networks using DHCP (dynamic host
configuration protocol). If this configuration is used, enter the computer
name in the position of the IP address.

To enable the external controller to communicate with the software via TCP/IP
protocol, set up a remote control link as follows:

1. Connect the controller and the instrument to the network (network cable) and
switch them on.

2. Start the 'Measurement & Automation Control' program on the controller.

3. Select "Devices and Interfaces > Create New".
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CBEX

¥ Devices and Interfaces - Measurement & Automation Explorer
File Edit View Tools Help

= My System
o 1 >
I sov L GBS ] Devices and Interfaces -
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What is Devices and Interfaces?
DNevices and Interfaces lists installed and detected CAN. )
@ Help

Select "VISA TCP/IP Resource" and confirm with "Next".
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Automation Explorer
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2 GPIBAA Interface
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5. Choose the type of TCP/IP resource you wish to add and select "Next".

Create New VI5A TCP/IP Resource...

Measurement & \";7

Automation Explorer

r ._ Chooze the type of TCP/P rezource you wish to add

e T
>
“ () Auto-detect of LAN Instrument
Uze thiz option to select from a list of Wl-11 LA /Lx=|
instruments detected on your local subnet.
i
(%) Manual Entry of LAN |nstrument

Use this aption if yaur W<1-17 LAMALX instrument is on
another network.

() Manual Entry of Raw Socket

Uze thiz option to communicate with an Etheret device
over a specific port number.

Enter the IP address or the host name of the R&S SGT and select "Next".

Enter the alias name if required.

The alias name must not be mistaken for the computer name. It is only used
for instrument identification within the program and displayed in the menu as
an option in case of an Ethernet link.

Confirm the settings with "Finish".
The instrument is configured and the settings are displayed in the "TCP/IP
Settings" tab.

To test the connection, select "Validate".
A message indicates whether the link to the instrument can be set up or not.
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If a connection cannot be set up, check whether the controller and the instru-
ment are connected to the network (network cable) and are switched on. Cor-
rect spelling of the IP address or the computer name should be checked. For
further error location, inform the network administrator. In large networks,
specification of additional addresses may be required for link setup, e.g. gate-
way and subnet mask, which are known to the network administrator.

The instrument is now registered in the program and can be addressed via the
resource string or alias name.

start a remote control session over LAN (using VXI-11)

. Start the "Measurement & Automation Explorer" on the controller.

In the "Configuration" window, select "Device and Interfaces > VISA TCP/IP
Resources", select the required instrument and select "Open VISA Test
Panel".

In the "viWrite" tab, write the command to be sent to the instrument and select
"Execute".

Instrument responses are displayed on the "viRead" tab.

Tip: For further program operation refer to the online help of the program.
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